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1

The following sections explain how to use this User 
Guide, and how to get additional support or provide 
feedback.

1. InDesign and InCopy Support

The version of Smart Styles described in this user guide 
is aimed for use with InDesign CC 2018 and InCopy ver-
sion CC 2018.

2. Using This User Guide

Please read the following sections to familiarize yourself 
with some of the symbols and terminology used in the 
User Guide, and some of the features that allow you to 
navigate the PDF if you are reading it on screen.

2.1  Icons

You will see various types of note icons in this manual. 
Their purpose is as follows:

An important note on a feature or action

A tip to improve your workflow

Introduction
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2.2  Terminology

The following terminology is used throughout this User 
Guide:

• Smart Styles Library. Contains Smart Styles 
elements that allow you to apply formatting to 
targeted text, tables and other page items.

• Smart Styles element. A formatted page 
item that has been added to the Smart Styles 
Library.

• Page Item. Any object within an InDesign 
document.

• Property Items. The properties of a Smart 
Styles element, grouped by Object Style, Text 
Style, and Table Style.

2.3  Navigating the PDF

To get the most out of this User Guide, view the PDF 
in Adobe Acrobat or Adobe Reader. Adobe Reader 

can be downloaded for free from www.adobe.com.

To assist you with navigating the PDF version of this User 
Guide and to aid you in quickly finding the section that 
you are after, the following interactive tools are available:

Contents. Click on a chapter or section title to 
immediately open the page.

Index. Click on a page number following an index 
entry to immediately open the page.

Bookmarks Panel. The bookmarks panel displays 
automatically when opening it. The PDF you open 
contains all chapters and sections; click on a title to 
automatically display the page.

Pages Panel. Click on a page thumbnail to imme-
diately open the page.

Hyperlinks. Displayed in gray, italic font. These are 
used to refer to other sections in the manual, Web 
sites or other external sources. When active, click-
ing it will forward you to another section within the 
manual or open a Web site.

http://www.adobe.com/
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3. Technical Support

Support for Smart Styles is available via our Support 
Community. If that doesn’t solve your issue, contact 
support@woodwing.com. 

Required information
In order to provide WoodWing Support with all relevant 
information, please do the following:

Step 1. Display the About WoodWing Plug-ins 
screen by doing the following:

• Mac OS: From the InDesign/InCopy 
menu, choose About WoodWing 
Plug-ins.

• Windows: From the Help menu, choose 
About WoodWing Plug-ins.

Step 2. Note down the version of Smart Styles 
that is installed and send it together with the 
version of Windows or Mac OS X you are using 
to WoodWing Support.

Figure 3. The About WoodWing Plug-ins screen.

https://helpcenter.woodwing.com/hc/en-us/community/topics
https://helpcenter.woodwing.com/hc/en-us/community/topics
mailto:support%40woodwing.com?subject=
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The Smart Styles plug-in delivers powerful format-
ting capabilities to InDesign users and adds table 
functionality (sorting and the use of formulas) to 
both InDesign and InCopy. 

Formatting features
The formatting feature of Smart Styles works by con-
verting any item on the layout to a Smart Styles Library 
element, thereby preserving not only object properties but 
text styles and table styles as well. All formatting options 
can then be applied in one sweep to a page item or table 
by dragging the Smart Styles element from the Smart 
Styles Library onto the item on the page. 

Since InCopy does not have support for libraries, 
the formatting features of Smart Styles are only 

available in InDesign.

Smart Styles elements are easily defined by creating an 
example with the desired formatting and subsequently 
dropping it into a Smart Styles Library. 

Once a Smart Styles library element is created, it is not 
a static object but can be used flexibly by selectively 
choosing which of its properties should be applied. 
Each Smart Styles element is divided into three property 
groups: Object Styles, Text Styles, and Table Styles. Each 
of these groups or their components can be selected or 
deselected, giving the user full control over which proper-
ties are applied at that moment.

With a single drag-and-drop, a Smart Styles element can 
apply table and object properties, multiple paragraph 
styles and attributes, per-paragraph multiple character 
styles and attributes to page items.

Smart Styles elements recognize a sequence of para-
graph styles and attributes. This allows you to set the 
formatting for the first paragraph(s), the last paragraph(s) 
and repeated formatting for the paragraphs in between. 
Repetition is not limited to a single format, but can consist 
of several paragraph formats. 

Per paragraph, Smart Styles allows the specification of a 
sequence of character styles and attributes from the start 
and end of the paragraph. For instance, you can make 
the first three words of a paragraph, or all characters up 
to the first comma, bold, without having to set a special 
invisible “end of style” marker first.

Smart Styles elements can be applied to selected 
text as well as entire text frames. 

Table features
Smart Styles also provides functionality for inserting for-
mulas into table cells so that calculations can be made, 
much the same as the functionality found in a spread-
sheet. Smart Styles also allows you to sort your data in 
a table; either by column, selection of cells, or complete 
table.

The table features are also available in InCopy.

About Smart Styles
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1. Flexibility and Efficiency

The Smart Styles elements drastically reduce the time 
required for repetitively formatting page elements, tables 
and text selections. This frees up your time to concentrate 
on the design and content, thus improving the overall 
quality of your publication.

• Smart Styles saves time by taking out 
the delay caused by repeated formatting. 
Multiple layouts with comparable formatting, 
such as those in magazines, newspapers and 
advertisements, become nearly effortless. 

• Global changes are quickly made. Replace 
an original Smart Styles Library element with a 
modified version. Reapply with a single com-
mand to automatically update all elements 
throughout a document that were formatted 
with the first version.

• Using Smart Styles, the number of actions 
needed to format page items decreases. 
Formatting a page item with InDesign requires 
an average of ten actions. With Smart Styles, it 
can be done with only one.

• Change a static table into a dynamic 
spreadsheet. Add formulas to cells for making 
calculations and sort your data in various ways.

• No additional “read” plug-in is needed. 
Applying a Smart Styles element will not 
result in a Smart Styles “footprint”; it’s all plain 
InDesign and you don’t need the Smart Styles 
plug-in to open the document, make changes, 
print or export.

• Smart Styles elements are stored in the 
standard InDesign Library. This makes it 
possible for multiple users to have access to 
the same Smart Styles Library, guaranteeing 
consistency. 

2. Smart Styles Interface

Smart Styles adds the following additional commands to 
the InDesign and InCopy interface:

• Library panel menu commands
• Table menu commands

Each command is explained in the following sections.

5
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2.1  Library Panel Menu Command

Smart Styles adds four commands to the Library panel 
menu.

• Smart Styles Properties. Opens the Smart 
Styles Properties dialog box for turning on/off 
individual properties before applying a Smart 
Styles element as well as for assigning a key-
board shortcut to the Smart Styles element.

• Apply Smart Style. Use to apply the selected 
Smart Styles element to the selected page item.

• Re-Apply Smart Style. Use to update an 
entire document quickly after modifying a Smart 
Styles element.

• Smart Styles Library. Use to toggle between 
an InDesign Object Library and a Smart Styles 
Library.

Figure 2.1 Smart Styles commands are added to the Library menu

A

A
A   Added Smart Styles commands

For more information about using these commands, see 
chapter 6, The Smart Styles Library.

6
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2.2  Table Menu Commands

Smart Styles adds the following commands to the Table 
menu in both InDesign and InCopy:

The same commands are available in the context 
menu of a table or cell (accessed by right-clicking 

the cell or table).

• Sort.... Opens the Sort dialog box for sorting 
the data in the table. (See figure 2.2a.)

• Formula. Contains a submenu with the fol-
lowing commands:

• Insert.... Opens the Insert dialog box for 
inserting a formula. (See figure 2.2b.)

• Update. For updating formulas in 
selected cells.

• Update All. For updating all formulas in 
a table.

• Show/Hide Fields. For showing or hiding 
text highlighting for any values in a cell that 
are the result of an inserted formula Figure 2.2a The Sort dialog box

Figure 2.2b The Formula dialog box

7
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3. Smart Styles Property Items

The following list is an overview of some of the properties 
that are retained when creating a Smart Styles Library 
item. (For a complete overview, see appendix C, Smart 
Styles Element Properties.)

Object Style properties
All standard page item properties are applied, including:

• Stroke properties (color, width, type, etc.)
• Fill properties
• Colors (including tints and gradients)
• Drop shadows
• Feathering
• Transparency
• Corner effects
• Inset
• Number of columns
• ...and many more

Text Style Properties
InDesign nested styles are applied like any other para-
graph style. 

Table Style Properties
Smart Styles elements can be applied to format indi-
vidually selected cells, a single table or every table in a 
document identically, including running headers and foot-
ers. Complex tables can be formatted, using the ability 
of Smart Styles to recognize sequences of formatting 
properties.

4. Smart Styles Sample Files

Two sample files are provided with Smart Styles con-
taining various examples for trying out the powerful 
functionality of Smart Styles:

• InDesign document: 
• Smart Styles SampleDoc.indt

•  InDesign Library file:
• SS Library.indl

Both files are automatically installed when opting to install 
the Smart Styles Example Files during the installation 
process (See chapter 3, Installing Smart Styles – sec-
tion 2, Installation). The files will be installed in a folder 
named WoodWing within the InDesign application folder. 
Instructions for using the files are contained within the 
InDesign document.

8
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5. Languages

Smart Styles is available in the following languages:

• English
• Dutch
• French
• German
• Italian
• Brazilian Portuguese
• Spanish
• Polish
• Russian
• Czech
• Chinese (Simplified and Traditional)
• Japanese
• Korean

6. New Features

The following new features have been implemented in 
Smart Styles:

• Support for Adobe InDesign CC 2018 and 
InCopy CC 2018.

• Paragraph borders: Draw attention to 
paragraphs in your layouts by adding border 
lines around them, and create custom corner 
designs for your paragraph borders.

• Object Styles enhancements: Set or modify 
an object’s size or position once to update it 
across your entire document using Object 
Styles.

• Automatically renew your license as a none-
admin user
 

9
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Installing Smart Styles

This chapter describes all steps required for install-
ing and uninstalling Smart Styles on Mac OS and 
Windows platforms.

1. System Requirements

Smart Styles requires the following minimums to be 
available:

Adobe applications
• Adobe InCopy CC 2018 or Adobe InDesign 
CC 2018. 

Operating system and hardware 
Smart Styles uses the requirements and recommenda-
tions as standard InDesign and InCopy. See www.adobe.
com for details. 

10

http://www.adobe.com/
http://www.adobe.com/
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2. Installation

The following sections describe installation steps for 
installing Smart Styles under Mac OS and Windows, both 
for licensed versions and trial versions.

Make sure to be logged in as an Administrator when 
installing the software.

2.1  Mac OS Installation

The Mac OS version of Smart Styles is delivered as an 
installer in .dmg format. 

To install Smart Styles on Mac OS, perform the following 
steps:

Step 1. Double-click the installer.

The Introduction screen appears.

Step 2. Click Continue. 

The License screen appears.

Step 3. Read the license agreement and click 
Continue followed by Agree.

The Installation Type screen appears.

Step 4. Select which items to install: 

• Smart Styles for InDesign CC 2018
• Plug-ins. The Smart Styles plug-ins for 
InDesign.
• Sample files. Sample files that accom-
pany this User Guide.

• Smart Styles for InCopy CC 2018
• Plug-ins. The Smart Styles plug-ins for 
InCopy. 

Step 5. Click Continue.

The installer is now ready to install Smart Styles 
in a default location (in InDesign CC 2018 or 
InCopy CC 2018 on the main hard drive).

Step 6. Click Install.

Step 7. Enter your system name and pass-
word and click Install Software.

11
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If you have more than one instance of InDesign 
CC 2018 or InCopy CC 2018 installed, 
the installer will prompt you to select in which 
ver-sion you want to install Smart Styles. 

Step 8. (Optional) Select the desired version 
and click OK.

The files will now be installed in the following 
locations: 

• Plug-ins. <InDesign/InCopy application
folder>/Plug-ins/WoodWing.
• Sample files. <InDesign/InCopy applica-
tion folder>/WoodWing

Step 9. When finished, click Close.

After installation, your copy of Smart Styles needs 
to be activated. For more information, see chapter 

4, Activating Smart Styles.

2.2  Windows Installation

The Windows version of Smart Styles is delivered as an 
installer in .zip format.

To install Smart Styles on a Windows platform, do the 
following:

Step 1. Unzip the downloaded file.

Step 2. Double-click the installer.

Step 3. Click Yes when prompted to allow this 
application to make changes to your computer.

The Choose Setup Language screen appears. 

Step 4. Choose either English or Japanese. 

Step 5. Click Next. 

The Introduction screen appears.

Step 6. Click Next.

Step 7. Read the license agreement and click 
the option I accept the terms of the license 
agreement.

Step 8. Click Next.

The Setup Type screen appears.

Step 9. Select which version of Smart Styles 
to install: 

• Smart Styles for InCopy CC 2018
• Smart Styles for InDesign CC 2018 

Step 10. Click Next.

The Choose Destination Location screen 
appears.

12
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Your installed version of InDesign or 
InCopy is automatically detected. The 

folder in which the application will be installed 
to is shown in the Destination Folder section at 
the bottom of the screen.

If InDesign or InCopy cannot be found in 
their default location and under their 

default application name, all available drives will 
be scanned. Please note that this could take 
some time.

Installing on Windows 64-bit versions
When installing Smart Styles in a 64-bit 
Windows environment, you will need to 
pay attention to the installation location. On 
Windows 64-bit it might be possible that there 
is a 32-bit and a 64-bit instance of InDesign or 
InCopy installed. The Smart Styles installer will 
present the first valid InDesign/InCopy that it 
finds; this could be a 32-bit or a 64-bit instance. 
If you have two InDesign/InCopy applications 
installed and you want to install Smart Styles 
on both InDesign installations, please run the 
installer a second time, and use the Browse 
button to point the installer to the destination 
you want.

For details about 32/64 bit Windows see 
Windows Help: 32-bit and 64-bit Windows: 
frequently asked questions.

Step 11. (Optional) Use the Browse button to 
browse to an instance of InDesign or InCopy 
which is installed in a different location.

Step 12. Click Next.

Step 13. (Optional) If you want to install the 
example files (an InDesign layout and a Smart 
Styles library), select the option Smart Styles 
- Example files.

Instructions for using the files are con-
tained within the InDesign document. 

Step 14. Click Next.

If you have chosen to install the Example 
files, the Choose Destination Location screen 
appears. By default, the example files will be 
installed in the same location as where your 
installation of InDesign or InCopy is installed. 
This location is shown in the Destination Folder 
section at the bottom of the screen.

Step 15. (Optional) Use the Browse button to 
choose a different location where the example 
files should be installed to. When back on the 
Choose Destination Location screen, click 
Next.

The files will now be installed in the following 
locations: 

• Plug-ins. <InDesign/InCopy application 
folder>\Plug-ins\WoodWing.
• Example files. <InDesign/InCopy appli-
cation folder>/WoodWing

Step 16. When finished, click OK to close the 
installer.

After installation, your copy of Smart Styles needs 
to be activated. For more information, see chapter 

4, Activating Smart Styles.

13
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3. Uninstalling Smart Styles

The installer for Smart Styles can also be used to remove 
the application from your system, as explained in the fol-
lowing sections.

3.1  Uninstalling from Mac OS

To uninstall Smart Styles from Mac OS, do the following:

Before uninstalling Smart Styles, close all open 
applications.

Step 1. Double-click the installer Smart 
Styles.app. 

Step 2. Enter your system name and 
password.

The Introduction screen appears.

Step 3. Click Continue. 

Step 4. The License screen appears.

Step 5. Click Continue followed by Agree. 

The Select Destination screen appears.

Step 6. Choose the drive on which InDesign or 
InCopy is installed and click Continue.

The Custom Install screen appears. 

Step 7. From the Custom Install list, choose 
Uninstall. 

Step 8. Click Uninstall.

Step 9. If you have more than one version 
of InDesign or InCopy installed, you will be 

prompted to select from which application 
you want to uninstall Smart Styles. Select the 
desired application and click OK. 

Smart Styles will be uninstalled. 

14
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3.2  Uninstalling from Windows

To uninstall Smart Styles from a Windows system, do 
the following:

Before uninstalling Smart Styles, close all open 
applications.

Step 1. Navigate to the Control Panel via the 
Windows Start menu and choose the option to 
uninstall programs (such as Add or Remove 
Programs or Uninstall a program.

Step 2. Choose Smart Styles from the list of 
installed programs.

Step 3. Click Remove.

Step 4. Confirm that you want to remove the 
selected application and all its components. 

Smart Styles will be uninstalled.

15
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After installation, your copy of Smart Styles needs 
to be activated. Without activation, Smart Styles 
will not function. 

This chapter will guide you through the different ways of 
activating Smart Styles and discusses how to transfer a 
Smart Styles activation to another system.

1. Activation

Smart Styles can either be activated as a trial version or 
as a licensed version.

Trial version
To try out Smart Styles without purchasing a license, the 
application can be activated for a period of 30 days after 
which it will stop working.

Licensed version
For activating your copy of Smart Styles as a licensed 
version, you need to purchase a valid license upon which 
you will receive a serial number.  

Before you activate, determine which workflow to 
use for this process. For flexibility, activation can be 

done immediately through the use of the internet. 
Alternatively, you can send an e-mail or fax with pertinent 
information after which an activation code will be send 
back to you within two working days.

Activating Smart Styles

16
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1.1  Welcome Screen and About Screen

Activation is achieved via the Welcome screen or the 
About WoodWing Plug-Ins screen.

Welcome screen
The Welcome screen automatically appears in the fol-
lowing situations:

• After starting up InDesign or InCopy for the first 
time after having installed a WoodWing plug-in 
(and as long as that product is not activated).
• At various times during the period when the 
product is activated as a demo version (showing 
the total number of days left) when starting up 
InDesign or InCopy.

Figure 1.1a The Welcome Screen

A

B C D

A   Non-activated product(s)  B   Activate Trial version
C   Activate product  D   Purchase product

The Welcome screen keeps appearing when start-
ing up the application, until all installed products 

have been activated (either as a trial version or as a 
licensed version). Either can be done via the Welcome 
screen or the About WoodWing Plug-Ins screen.

About WoodWing Plug-ins screen
The About WoodWing Plug-Ins screen automatically 
appears in the following situations:

• After an activation has been transferred (in 
case the product needs to be activated again).
• During the period when the product is acti-
vated with a time limited serial number, each 
time InDesign or InCopy is started (showing the 
total number of days left). 

The About WoodWing Plug-Ins screen can also be dis-
played at any time by doing the following:

• Mac OS: From the InDesign/InCopy menu, 
choose About WoodWing Plug-ins... .
• Windows: From the Help menu, choose 
About WoodWing Plug-ins... .

Figure 1.1b The About WoodWing Plug-ins Screen

A

B C D

A   Installed product(s) with status  B   Activate Trial version
C   Transfer Activation  D   Activate product

17
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The following components are available in the Welcome 
screen and the About WoodWing Plug-Ins screen:

• Installed products. 
• Welcome screen: shows all non-acti-
vated products or those that have been 
activated for a trial period. 
• About WoodWing Plug-ins screen: 
shows all installed products with their 
current status: Not Activated, Activated, 
Expires in x days, Expired. When more 
products are installed than can fit on-
screen, navigation buttons to the right and 
left can be used to scroll through the list. 

• 30-Day Trial button. For activating the prod-
uct as a trial.

• Activate. For activating the product as a 
licensed version.

• Transfer Activation. (About WoodWing 
Plug-Ins screen only). For transferring a license 
to a different system.

• Purchase. (Welcome screen only) For launch-
ing the WoodWing store in the default Web 
browser.

2. Activating Smart Styles

The activation process can be started from either the 
Welcome screen or the About WoodWing Plug-Ins 
screen. 

As long as a plug-in has not been activated, a 
Welcome screen showing that plug-in will appear 

when starting InDesign or InCopy. The About WoodWing 
Plug-Ins screen shows all installed WoodWing products 
with their respective activation status at any time. (For 
more information about these screens, see section 1.1 
Welcome Screen and About Screen).

Smart Styles can be activated as a fully functional time 
limited trial or as a licensed version, as explained in the 
following sections. 

18
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2.1  Trial Version

To activate Smart Styles as a trial version, perform the 
following steps:

Step 1. From the list of products on the 
Welcome screen or the About WoodWing Plug-
Ins screen, choose Smart Styles.

The 30-day Trial button becomes available.

Step 2. Click 30-day Trial. 

The Personal Details screen appears.

Step 3. Fill in all details. (All required fields are 
marked in bold).

Step 4. Click Next.

The Proxy screen appears.

Step 5. (Optional) When a proxy server is used, 
select the Use a HTTP proxy server check box 
and fill in all details.

Figure 2.1a The Personal Details screen

Figure 2.1b The Proxy screen

Step 6. Click Next.

(Mac OS X only) A screen appears asking for 
which users Smart Styles need to be activated: 
for all users or the current user only.

Figure 2.1c Choosing for which users Smart Styles should 
be activated
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Step 7. Make your choice and click Next.

Step 8. When prompted to enter the system 
administrator’s password, enter it and click OK.

When activation is successful, this is displayed 
on-screen.

Figure 2.1d Activation successful

Verify the About WoodWing Plug-Ins screen for the 
remaining number of days in the trial period. 

2.2  Licensed Version

To activate Smart Styles as a licensed version, perform 
the following steps:

Step 1. From the list of products on the 
Welcome screen, the About WoodWing Plug-
Ins screen, or the More Info screen, choose 
Smart Styles.

The Activate button becomes available.

Step 2. Click Activate.

The Introduction screen appears.

From here, you have the option to activate offline 
or via the Internet, as explained in section 2.2.1 
Offline Activation, and section 2.2.2 Online 
Actiavation.

Figure 2.2a The Introduction screen
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2.2.1 Offline Activation

To activate Smart Styles offline, perform the following 
steps: (for the first two steps in this process, see section 
2.2 Licensed Version.)

Step 3. Select the check box I don’t have 
access to the Internet....

Step 4. Click Next.

The Serial Number screen appears.

Figure 2.2.1a The Serial Number screen

Step 5. Send in the following info by e-mail or 
fax (see the Serial Number screen for contact 
details):

• Your WoodWing serial number
• Your Adobe InDesign serial number 

Click the Copy button to copy the 
displayed serial number to your 

clipboard.
• Contact details (including name, company 
name, e-mail, and address)
• Platform used (Mac OS or Windows) 

Step 6. Click Cancel to terminate the activa-
tion process for now.

Within two business days, your authorization 
code will be e-mailed or faxed to you. Both 
methods require a different way of activating 
the software.
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After the authorization code is delivered by 
e-mail:

Step 7. You wi l l  rece ive a f i le named 
WWActivate.xml. Place this in the following 
location:

• Mac OS:
Library/Application Support/WoodWing

• Windows Vista/Windows 7/8:
C:\ProgramData\WoodWing

Step 8. Restart InDesign or InCopy.

The product is automatically activated.

Step 9. To verify that the activation has been 
successful, open the About WoodWing Plug-
ins screen:

• Mac OS: From the InDesign/InCopy 
menu, choose About WoodWing Plug-
ins... .
• Windows: From the Help menu, choose 
About WoodWing Plug-ins... .

Step 10. The Smart Styles product should now 
have the status Activated. 

After the authorization code is delivered by fax:

Step 7. Return to the Welcome screen or the 
About WoodWing Plug-Ins screen. (See section 
1.1 Welcome Screen and About Screen.)

Step 8. From the list of products, select Smart 
Styles.

Step 9. Click Activate.

Step 10. Select the check box I don’t have 
access to the Internet... .

Step 11. Click Next and Next again.

Step 12. In the dialog box that appears, enter 
your WoodWing serial number and the received 
authorization code exactly as they are deliv-
ered—including dashes, capitals, etc.

Figure 2.2.1b Enter the received authorization code

Step 13. Click Next to start the authorization 
process.
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When activation is successful, this is displayed 
on-screen.

Figure 2.2.1c Activation successful

Step 14. Click Finish and restart InDesign or 
InCopy.

2.2.2 Online Activation

To activate Smart Styles online, perform the following 
steps: (for the first two steps in this process, see section 
2.2 Licensed Version.)

Step 3. Click Next.

Step 4. In the screen that appears, enter 
the serial number for Smart Styles that you 
received.

Step 5. Click Next.

The Personal Details screen appears.

Step 6. Fill in all details. (All required fields are 
marked in bold).

Step 7. Click Next.

The Proxy screen appears.

Figure 2.2.2a Enter the WoodWing serial number
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(Mac OS X only) A screen appears asking for 
which users Smart Styles need to be activated: 
for all users or the current user only.

Figure 2.2.2b Choosing for which users Smart Styles should 
be activated

Step 8. Make your choice and click Next.

Step 9. When prompted to enter the system 
administrator’s password, enter it and click OK.

Step 10. (Optional) When a proxy server is used, 
select the Use a HTTP proxy server check box 
and fill in all details.

Step 11. Click Next.

When activation is successful, this is displayed 
on-screen.

3. Transferring an Activation

Once the Smart Styles software has been activated, it is 
possible to transfer your serial number to another com-
puter. You still have only one license, but this will allow you 
to switch to another computer if needed.

Step 1. Display the About WoodWing Plug-ins 
Plug-Ins screen by doing the following:

• Mac OS: From the InDesign/InCopy 
menu, choose About WoodWing 
Plug-ins.
• Windows: From the Help menu, choose 
About WoodWing Plug-ins.

Step 2. Select Smart Styles.

Step 3. Click Transfer Activation. 

A message appears indicating that the serial 
number must be validated via the internet.

Step 4. Click Next.

The Proxy screen appears.

Step 5. (Optional) When a proxy server is used, 
select the Use a HTTP proxy server check box 
and fill in all details.

Step 6. Click Next.

Step 7. Upon activation results, click Finish.

You can now install and activate Smart Styles 
on a different system.
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Before explaining the product in detail, this chapter 
gives a brief explanation about how to work with a 
Smart Styles library and how to work with the table 
features of Smart Styles.

1. The Object Library

Smart Styles works by making use of InDesign’s Object 
Library feature. The basic InDesign Object Library is used 
for storing objects such as formatted frames and tables 
so that they can be reused at a later stage simply by drag-
ging them from the library onto the layout as new objects.

Smart Styles takes this process a step further by making 
it possible to drag an item from the library onto a page 
item and thereby applying the formatting properties of the 
library item to the target item on the page. 

With Smart Styles installed, the object library that you 
have created can either behave as a regular InDesign 
Object library or as a Smart Styles library, depending on 
which command is selected in the library panel’s menu.

For more information about InDesign Object 
Libraries, see InDesign Help.

Getting Started
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1.1  Smart Styles Basics

A Smart Styles element can be created once and applied 
repeatedly to page items, text, or tables. While complex 
formatting can be applied, the basic process for using 
Smart Styles is very simple:

Step 1. Create a new Smart Styles Library, 
or easily transform an InDesign Object Library 
into a Smart Styles Library. (For more informa-
tion about creating Object Libraries, see chapter 
6, The Smart Styles Library.)

Step 2. Apply InDesign formatting prop-
erties to a page item, including text or table 
formatting.

Step 3. Drag the same item into the Smart 
Styles Library.

Step 4. Use one of the following methods:

• Apply the Smart Styles element to a page 
item by dragging it from the Library onto 
the target page item.
• With the page item selected, Right-click 
the library item and choose Apply Smart 
Style.
• With the page item selected, choose 
Apply Smart Style from the Library menu.

Figure 1.1 Creating and applying a Smart Styles 
item

1.2  Flexibility

Smart Styles adds enormous flexibility to a user’s 
workflow: 

• Multiple users simply open a Smart Styles 
Library to maintain consistency. Once a 
Smart Styles Library is created with formatted 
elements, the library exists as a separate file. By 
sharing this file with others, managing consis-
tency throughout a workflow process involving 
numerous documents is easy. Any user can 
open the Library and have access to the same 
styling formats. 

• Formatting can still be modified after a 
style has been applied. Once Smart Styles 
formatting is applied to a page item, it can still 
be reformatted using InDesign’s standard for-
matting features. You are not restricted to the 
original styles applied. However, if consistency 
between page items is important, you can 
choose to modify the Smart Styles element and 
reapply it globally throughout the document. 
(For more information about modifying Smart 
Styles elements, see chapter 9, Modifying a 
Smart Styles Element.)

• Open, revise and print the document 
without having the plug-in installed. 
Anyone can open, make revisions, modify for-
matting, and print or export the file using the 
features of InDesign or InCopy. No plug-in is 
required to read a document that has been for-
matted with Smart Styles. 

• Management of styles and swatches. 
Paragraph styles, character styles, object 
styles, and color swatches used by Smart 
Styles are automatically copied to a document, 
even if they are not yet available within the docu-
ment. There is no need to load these formatting 
features separately.
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2. Tables

With Smart Styles, tables can be sorted and formulas 
can be quickly inserted into a table cell, as explained in 
the next sections.

2.1  Sorting a Table

To sort a table, perform the following steps:

Step 1. Place the text cursor in any cell of a 
created table.

Step 2. Use one of the following methods:

• From the Table menu, choose Sort....
• Right-click the table and choose Sort....

The Sort dialog box appears.

Step 3. Make the required selections from 
the Column sorting, Sorting range, and 
Language sections.

Figure 2.1 The Sort dialog box

27



Chapter 05  Getting Started

Step 4. Click OK.

The table is sorted.

For more information about sorting tables, see chapter 12, 
Working With Tables – section 5, Sorting Tables.

2.2  Inserting a Formula

To insert a formula into a table cell, perform the following 
steps:

Step 1. Place the text cursor in the cell in which 
the formula needs to be inserted.

Step 2. Do one of the following:

• From the Table menu, choose Formula 
followed by Insert.
• Right-click on the cell or table and choose 
Formula followed by Insert.

The Formula dialog box appears.

Figure 2.2 The Formula dialog box

Step 3. Enter a formula and number format.

Step 4. Click OK.

The formula is inserted.

For more information about using formulas, see chapter 
12, Working With Tables – section 4, Using Formulas.
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Smart Styles uses the Library feature of InDesign to 
make creating and navigating a Smart Styles library 
effortless. You can either create a new Smart Styles 
library or use an existing InDesign Object Library as 
a Smart Styles library. An older version of a Smart 
Styles library can also be easily converted to work 
with Smart Styles.

This chapter explains how to create a Smart Styles library 
from scratch, how to convert a library created with a previ-
ous version of Smart Styles, and how to use the Library 
panel.

The Smart Styles Library

1. The Library Panel

Figure 1 shows the general options of the default InDesign 
Library panel. 

Figure 1. The InDesign Library panel

A   Panel menu  B   Element thumbnail and name
C   Item information  D   Show library subset
E   New library item  F   Delete library item

A

B

FEDC
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Smart Styles adds four additional commands to the 
library menu:

• Smart Styles Properties. Use to turn on/off 
individual properties before applying a Smart 
Styles element and for assigning a keyboard 
shortcut to the Smart Styles element.

• Apply Smart Style. Use to apply a selected 
Smart Styles element.

• Re-Apply Smart Style. Use to update an 
entire document quickly after modifying a Smart 
Styles element.

• Smart Styles Library. Use to toggle between 
an InDesign Object Library and a Smart Styles 
Library.

You will learn how to use these options throughout this 
guide. (Further information on the InDesign Object Library 
can be found in InDesign Help.)

2. Creating a Smart Styles Library

To create a new Smart Styles Library, do the following:

Step 1. From the File menu, choose New, fol-
lowed by Smart Styles Library.

The New Smart Styles Library dialog box 
appears.

Step 2. Enter a file name and browse to a loca-
tion where the file needs to be saved.

Step 3. Click Save.

The library will appear as a separate panel or in 
a panel together with already opened libraries.

Figure 2. The Library panel

InDesign library files are saved as .indl files and can 
be opened by choosing Open from the File menu.

30



Chapter 06  The Smart Styles Library

3. Changing the Library Behavior

The Library panel can be made to behave as either a reg-
ular InDesign Object Library or as a Smart Styles Library 
by choosing the appropriate command in the menu of the 
Library panel. This way, even objects that were originally 
created as an InDesign Library object can be made to 
behave as a Smart Styles Library object and vice versa.

To change the behavior of a library, do the following:

Step 1. Open the Library menu. 

The current behavior of the Library is indicated 
by the check mark in front of Object Library or 
Smart Styles Library. 

Figure 4. The library commands in the panel menu

A   Object Library command
B   Smart Styles Library command

B

A

Step 2. To change the behavior, choose 
Object Library or Smart Styles Library 
respectively.
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4. The Item Information Dialog Box

The Item Information dialog box can be displayed for 
viewing and/or editing item information such as the item 
name or object type. This affects the way the items are 
displayed and sorted in the library panel.

Figure 4. The Item Information dialog box

A   Item preview  B   Creation date  C   Description box
D   Object type list  E   Item name box

B D ECA

The Item Information dialog box contains the following 
options:

• Item preview. Shows a preview of the item.

• Item Name. Shows the current name for 
the item. Items added to the library are named 
‘Untitled’ by default. To easily identify each item 
as well as to better be able to sort them by 
name, it is advisable to give each item a more 
descriptive name. (Note that it is possible to 
keep library objects with identical item names 
and object types.) 

• Object Type list. Shows the currently 
assigned item type. Choose between Image, 
EPS, PDF, Geometry, Page, Text, Structure, 
or InDesign File. Choosing between different 
object types does not change the properties 
of the Smart Styles element, but affects the 

way items are sorted by Object Type. It will also 
change the icon that appears next to the item 
when the library panel is displayed in List View.

• Creation Date. Date and time when the item 
was added to the library.

• Description. Use to leave a short description. 
This is especially useful when sharing the library 
with other users.

To display the Item Information dialog box, do one of the 
following:

• Hold down the Option key (Mac OS) or Alt key 
(Windows) when adding an item to the library. 
(Note that when multiple items are added at 
once, Item Information dialog boxes will appear 
for each item individually).

• Double-click an element in the Library.

• Select a library item, open the library menu and 
choose Item Information.

• Select a library item and click the Item 
Information button at the bottom of the panel.

• Right-click a library item and choose Item 
Information from the context menu.
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5. Deleting a Library Item

To delete an item from the library, do the following:

Step 1. Select one or more library item(s).

Step 2. Use one of the following methods:

• Click the Trash Can icon at the bottom 
of the panel.

• Drag the selected items on top of the 
Trash Can icon.

• Choose Delete Item(s) from the library 
menu. 

• Right-click one of the selected items and 
choose Delete Item(s) from the context 
menu.

In all cases, a message will appear, asking you 
to confirm the deletion of the item.

Step 3. Respond to the message as follows:

• Click Yes to delete the library item. 
• Click No to not delete the library item.
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This chapter describes in detail how to create a 
Smart Styles element from scratch, and how to 
rename it once it has been created.

Creating a Smart Styles Element

1. Creating

To create a new Smart Styles element, perform the fol-
lowing steps: 

Step 1. Create a new page item or use an exist-
ing page item such as a text or graphic frame. 
Use InDesign’s standard features to apply for-
matting to either the object itself (shape and 
appearance) and/or its content (text or table). 

Step 2. Use one of the following methods:

• Select one or more page items and drag 
them onto the Smart Styles Library. 

When multiple items are dragged 
onto the library, these will be added 

as one item.

Hold down the Option key (Mac OS) 
or Alt key (Windows) to immediately 

display the Item Information dialog box for 
naming the item. (For more information, see 
section 2. Naming the Smart Styles 
Element.)

• Select one or more page items and click 
the New Library Item button ( ) in the 
Library panel. (Note: when multiple items 
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are selected, these will be added to the 
library as one item.) 

• Select one or more page items and 
choose Add Item from the Library menu. 

When multiple items are dragged 
onto the library, these will be added 

as one item.

• From the Library menu, choose one of the 
following commands (no page items need 
to be selected):

• Add Items on Page [number]. For 
adding all items on the current page as 
one library object.

• Add Items on Page [number] as 
Separate Objects. For adding all 
items on the current page as separate 
library objects.

2. Naming the Smart Styles Element

When a Smart Styles Element is created by using one 
of the methods described above, they are automatically 
named ‘Untitled’ by default. To easily identify each item as 
well as to better be able to sort them by name, it is advis-
able to give each item a more descriptive name. (Note 
that it is possible to keep library objects with identical item 
names and object types.) 

For changing the name of the item, the Item Information 
dialog box is used. (See chapter 6, The Smart Styles 
Library – section 5, The Item Information Dialog Box.)

Figure 2. The Item Information Dialog Box

To (re-)name a library object, do the following:

Step 1. Display the Item Information dialog 
box by doing one of the following:

• Hold down the Option key (Mac OS) or 
Alt key (Windows) when adding an item to 
the library.

• Double-click an element in the Library.

• Select a library item and choose Item 
Information from the Library menu.

• Select a library item and click the Item 
Information button (   ) at the bottom of 
the panel.
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• Right-click a library item and choose Item 
Information from the context menu.

Step 2. Enter a descriptive name in the Item 
Name box.

Step 3. Click OK.

Chapter 07  Creating a Smart Styles Element
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This chapter explains in detail how to apply a Smart 
Styles element to a page item—including single 
items, multiple items, text and tables. 

Also explained is the method of applying only certain 
properties of a Smart Styles element as well as how to 
assign a keyboard shortcut to an element.

1. Applying Specific Element Properties

Smart Styles enables you to create intricate item and text 
formatting and build complex tables. These Smart Styles 
Library elements can contain many different formatting 
properties. For design purposes, you may want to apply 
only part of the properties associated with a particular 
Smart Styles element, but retain the original formatting 
for later use. 

To view the current formatting of any Smart Styles 
element in the library, hold down the Option key 

(Mac OS) or the Alt key (Windows) and drag the Smart 
Styles element onto the page.

Smart Styles Properties
The Smart Styles Properties allow you to selectively 
modify a Smart Styles element before you apply it. 
Three groups of properties exist: Object Styles, Text 
Styles, and Table Styles; each containing their specific 
formatting properties. (For a more detailed description 
of these properties, see chapter 10, Smart Styles Page 
Elements, chapter 11, Creating a Text Element, chapter 
12, Working with Tables, and appendix C, Smart Styles 
Element Properties.)

Applying a Smart Styles Element
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To access the Smart Styles Properties, perform the fol-
lowing steps:

Step 1. Select a Smart Styles element in the 
Library.

Step 2. Use one of the following methods:

• From the panel menu, choose Smart 
Styles Properties.

• Right-click an element and choose Smart 
Styles Properties from the context menu.

The Smart Styles Properties dialog box 
appears.

Figure 1. The Smart Styles Properties dialog box

Each Smart Styles property is part of one of the follow-
ing groups:

• Object Style. Controls the style of an object 
(not the text or table that it may contain).
• Text Style. Controls text formatting only (not 
the frame that it is part of).

• Table Style. Controls the formatting of the 
table and the text that the table contains.

For a full overview of all Smart Styles properties, 
see appendix C, Smart Styles Element Properties.

Check boxes are used for selecting or clearing properties 
or groups of properties. In case of grouped properties, 
the following indicators are used:

Table 1. Indicators
Mac OS Windows

All group items selected

At least one group item 
not selected

No items selected

To view and select from additional options, click the 
expander next to the group.

To turn off an entire group, simply click to clear the 
check box. 

The following example illustrates the results of turning off 
individual Object Styles in the Smart Styles Properties 
dialog box:

WoodWing
Smart Styles WoodWing

Smart Styles

WoodWing
Smart Styles

Original text with 
no formatting

A formatted page 
item turned into a 
Smart Styles

T h e  S m a r t 
Styles element 
applied with only 
Paragraph Styles 
and Drop Shadow 
selected
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2. Applying an Element To Page Items

When a Smart Styles Element is applied to a targeted 
page item, the target acquires all of the formatting prop-
erties that are assigned to the element. (See also section 
1. Applying Specific Element Properties.) 

Smart Styles elements can be applied to a single page 
item, to multiple page items, to text or to tables. 

A Smart Styles element can be applied in one of the fol-
lowing ways:

• To a single page item
• To multiple page items at once
• To text
• To tables or table cells

Each method is explained in the following sections.

2.1  Applying To a Single Page Item

To apply a Smart Styles element to a single page item, 
do one of the following:

Make sure that Smart Styles Library is selected in 
the Library panel menu.

• Drag the desired element from the Smart 
Styles Library and drop it onto the page item 
to be styled. 

• Select the target page item. Then select an 
element in the Library panel. From the Library 
menu, choose Apply Smart Style.

• Select the target page item. In the Library 
panel, right-click an item and choose Apply 
Smart Style from the context menu..

For important information about applying Frame 
Width Settings, see section 3. Frame Width 

Settings.

Chapter 08  Applying a Smart Styles Element
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2.2  Applying To Multiple Page Items

To apply a Smart Styles element to multiple page items, 
do one of the following:

Make sure that Smart Styles Library is selected in 
the Library panel menu.

Step 1. Select the page items you want to style. 

Step 2. Use one of the following methods:

• Select the desired element from the 
Library. From the Library menu, choose 
Apply Smart Style.

• In the Library panel, right-click an item 
and choose Apply Smart Style from the 
context menu. 

For important information about applying Frame 
Width Settings, see section 3. Frame Width 

Settings.

2.3  Applying To Text

There may be times that you want to apply the text for-
matting properties of a Smart Styles element to selected 
areas of text only. Smart Styles caters for this as well.

To apply a Smart Styles element to a text selection, per-
form the following steps:

Step 1. Select only the text to be styled.

Step 2. Use one of the following methods:

• Drag the desired Smart Styles element 
from the Library onto the selected text. 
While dragging, the mouse pointer changes 
into a paintbrush (  ).

• Select the desired Smart Styles element 
from the Library and choose Apply Smart 
Style from the Library menu.

• Right-click the Smart Styles element that 
you want to apply to the selected text and 
choose Apply Smart Style from the con-
text menu.

Even though object properties may be selected 
in the applied Smart Styles element, only the 
Text Style properties are applied.

If the Paragraph Style and Paragraph 
Settings properties are set, Smart Styles 

will format the complete paragraph, even if only 
part of a paragraph is selected. (See section 1. 
Applying Specific Elelement Proerties.)

For more detailed information about the Text Style proper-
ties of a Smart Styles element, see chapter 11, Creating 
a Text Element.

Chapter 08  Applying a Smart Styles Element
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2.4  Applying To Tables and Cells

Smart Styles allows you to format a single cell, a single 
table or multiple tables that are part of a text frame at 
once, as explained in the following sections.

2.4.1 Applying To Tables

To apply a Smart Styles table element to a table, use one 
of the following methods:

• Drag the desired Smart Styles element from 
the Library onto the table. 

• Select the whole table and do one of the 
following:

• Drag the Smart Styles element from the 
Library onto the table.

• Select the Smart Styles element in the 
Library. From the panel menu, choose 
Apply Smart Style.

• Right-click the Smart Styles element in the 
Library and choose Apply Smart Style 
from the context menu. 

As a Smart Styles table element is dragged from the 
Library over a table, the paintbrush pointer (  ) changes 
to include a small table symbol (  ). 

Look at the pointer before releasing the Smart 
Styles element to make sure that you are accurately 

targeting either the text frame or the table. If the table 
symbol is visible, formatting will be applied to that table 
only. If the paintbrush pointer does not include the table 
symbol, formatting will be applied to the entire text frame 
including all tables within.

If more than one table exists within the Smart Styles 
element, the first table inside the element is used to 

style the target.

Chapter 08  Applying a Smart Styles Element
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2.4.2 Applying To Table Cells

To apply a Smart Styles table element to one or more 
individual cells, perform the following steps:

Step 1. Select one or more table cells.

Step 2. Use one of the following methods:

• Drag a Smart Styles table element onto 
the selected cells. 

• From the panel menu, choose Apply 
Smart Style.

• Right-click a Smart Styles element and 
choose Apply Smart Style from the con-
text menu. 

When applying a Smart Styles table element to individual 
cells, all cell formatting options are applied. Alternating fill 
and stroke options are not applied; they are recognized 
as table formatting options, which must be applied to 
the entire table.

As a Smart Styles table element is dragged from the 
Library over a table, the paintbrush pointer (  ) changes 
to include a small table symbol (  ). 

Look at the pointer before releasing the Smart 
Styles element to make sure that you are accurately 

targeting either the text frame or the table. If the table 
symbol is visible, formatting will be applied to that table 
only. If the paintbrush pointer does not include the table 
symbol, formatting will be applied to the entire text frame 
including all tables within.

2.4.3 Applying To a Text Frame With Tables

To apply a Smart Styles table element to a complete text 
frame including all tables it contains, perform the follow-
ing steps:

• Drag the desired Smart Styles element from 
the Library onto a text frame, outside any of its 
tables. 

This will format the complete text frame, including all 
tables inside. If the target text frame contains more tables 
than defined in the Smart Styles, all additional tables will 
be formatted by the properties in the last table of the 
Smart Styles element.

As a Smart Styles table element is dragged from the 
Library over a table, the paintbrush pointer (  ) changes 
to include a small table symbol (  ). 

Look at the pointer before releasing the Smart 
Styles element to insure accurate targeting of either 

a text frame or table. If the table symbol is visible, format-
ting will be applied to that table only. If the paintbrush 
pointer does not include the table symbol, formatting will 
be applied to the entire text frame including all tables 
within.

Chapter 08  Applying a Smart Styles Element
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3. Frame Width Settings

Applying the Smart Styles Frame Width property of a 
Smart Styles element needs particular attention, espe-
cially when it comes to using the following settings: 

• Match Width of Columns. Matches the 
width of the column(s) in the target frame with 
the column width of the source frame.

• Match Number of Columns. Matches the 
number of columns of the target frame with the 
number of columns of the source frame.

• Match Gutter Width. Matches the gutter 
width of the target frame with the gutter width 
of the source frame.

• Match Width. Matches the overall width of 
the target frame with the width of the source 
frame.

Table 3. Smart Style Frame Width settings relations
Rule # When these settings are enabled: This setting should also be enabled: 1

1
Match Width
Match Width of Columns
Match Gutter Width

Match Number of Columns

2
Match Width
Match Number of Columns
Match Gutter Width

Match Width of Columns

3
Match Width
Match Width of Columns
Match Number of Columns

Match Gutter Width

4 Match Width
Match Width of Columns

Match Number of Columns
Match Gutter Width

1 When not set manually, it will be set automatically by 
Smart Styles (a message will appear to inform you about 
this).

Note that a direct relationship exists between certain set-
tings and that when one of these settings is used, the 
related setting must also be used.

For example: when selecting Match Column Width, the 
Match Number of Columns setting and the Match Gutter 
Width setting also needs to be used. 

The good news is that you don’t need to know or remem-
ber these relationships: Smart Styles will take care of 
that for you. Whenever a setting is not selected while it 
is required because of the selection of its related setting, 
Smart Styles will inform you about this by showing a mes-
sage. When agreeing that the change should take place, 
Smart Styles will automatically select all of the related 
settings for you. 

Table 3 shows the scenarios in which you will see such 
a message appear.

The Frame Width setting Match Resize Behavior is 
not affected by these scenarios.

Chapter 08  Applying a Smart Styles Element
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4. Assigning a Keyboard Shortcut 

In order to make the process of applying a Smart Styles 
element to a page item even more convenient, a keyboard 
shortcut can be assigned to each element by doing the 
following:

Step 1. Bring up the Smart Styles Properties 
dialog box by doing one of the following:

• Select a Smart Styles element and choose 
Smart Styles Properties from the Library 
menu.

• Right-click a Smart Styles element and 
choose Smart Styles Properties from 
the context menu.

Step 2. In the Shortcut box enter a keyboard 
command.

Take note of the following:

• Only numeric keys from the numeric key-
pad can be used (that is: numbers 1-0 
only, not any of the other keys found on the 
numeric keypad such as “/”, “+”, etc.)

• The following modifiers keys can be used 
in combination with the numeric keys:

• Mac OS: Command, Option, Shift 
• Windows: Control, Alt, Shift

If the keyboard shortcut has already been 
used, an alert will sound and another 

choice needs to be made. 

Figure 4. The Smart Styles Properties dialog box

Chapter 08  Applying a Smart Styles Element
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Once a Smart Styles element has been created and 
applied to page items, there may come a time when 
the element needs to be altered permanently, or 
you may want to modify an element and then apply 
the modifications globally to all previously styled 
page items. Smart Styles offers solutions to both of 
these examples, as explained in this chapter.

1. Modifying a Smart Styles Element

A Smart Styles element that is stored in a library can at 
any time be altered and updated by doing the following:

Step 1. Use one of the following methods:

• While holding down the Option key (Mac 
OS) or Alt key (Windows), drag a Smart 
Styles element from the library onto the 
layout. The element will be placed onto the 
layout as an editable object.

• Modify a page item that was previously 
styled by the Smart Styles element which 
you want to replace.

Step 2. Once the modification is complete, 
drag the newly formatted page item onto the 
Smart Styles Library. 

A message appears, asking wether the existing Smart 
Styles element needs to be replaced. 

Step 3. Respond to the message as follows:

• Click Yes to replace the existing Smart 
Styles element. The original element is 
automatically removed from the Library 
and the current selection is named with 
the exact same name. All page items that 

Modifying a Smart Styles Element
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were styled with the original element can 
easily be updated. (This needs to be done 
as a separate action. For more information, 
see section 2. Making Global Changes to 
an Element.

• Click No to retain the existing Smart 
Styles element and add the modified ver-
sion to the Library as a new Smart Styles 
element. It will be added to the library with 
the name ‘Untitled’.

• Click Cancel to cancel the action and 
return to the layout without adding the ele-
ment to the library.

2. Making Global Changes To an Element

When an existing Smart Styles element is updated with 
a new version (see section 1. Modifying a Smart Styles 
Element), it can be used to make global changes. 

To apply the modified Smart Styles element to all page 
items that were styled by the original element, perform 
the following steps: 

Step 1. Select the updated element in the 
Library.

Step 2. Use one of the following methods:

• From the Library menu, choose Re-Apply 
Smart Style.

• Right-click on the Smart Styles element 
and choose Re-Apply Smart Style from 
the context menu.

All page items in the document that were previously 
formatted with the original Smart Styles element will auto-
matically take on the formatting properties of the newly 
created Smart Styles element.

These changes will only be applied to the document 
that is currently being worked on. If the same Smart 

Styles element has been used in other documents, then 
these have to be updated in the same way.

Chapter 09  Modifying a Smart Styles Element
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This chapter describes how to create Smart Styles 
page elements. Smart Styles page elements are 
elements that only contain object formatting prop-
erties. When applied to target items they will only 
affect the appearance of the object and not its con-
tent (such as text or a table).

1. Page Element Properties

Smart Styles Page Elements can be created from any 
page item that consists of frames or paths. This includes 
all graphic frames, text frames, and unassigned frames. 
They can be styled using InDesign’s page formatting fea-
tures and subsequently converted into a Smart Styles 
element by dragging it into the Smart Styles Library. 

The following properties can be used separately or com-
bined to style a page item: 

For a complete overview, see appendix C, Smart 
Styles Element Properties.

• Stroke: weight, miter limit, type, start, end, 
cap, join
• Attributes: overprint fill, overprint stroke and 
non-printing
• Colors (stroke and fill): including tints and 
gradient colors with their angle and start and 
end points
• Drop Shadows 
• Feathering 
• Interactive settings
• Transparency settings
• Corner Effects
• Text Wrap
• Frame Based Grids
• Object Styles
� (Continues on next page)

Smart Styles Page Elements

47



Chapter 10  Smart Styles Page Elements

• Effects: (stroke transparency, inner shadow, 
outer glow, inner glow, bevel and emboss, satin, 
directional feather, gradient feather)
• Frame Fitting
• Shape properties
• Match frame width and height. (For more 
information, see chapter 8 Applying a Smart 
Styles Element – section 1, Applying Specific 
Element Properties.)
• Table styles
• Cell styles
• Object Export Options

2. Creating a Page Element

To create a new Smart Styles Page element, perform the 
following steps: 

Step 1. Create a new page item, or use an 
existing page item such as an object or graphic 
frame.

Make sure that it does not contain any text 
since this will turn it into a combined 

page/text element. Note however that any text 
formatting properties can always be disabled 
via the Smart Styles Properties dialog box once 
the element is created. (For more information, 
see chapter 8 Applying a Smart Styles Element 
– section 1, Applying Specif ic Element 
Properties.) 

Step 2. Use InDesign’s standard features to 
apply any of the properties listed above to the 
item (you are not limited to the number of prop-
erties that can be applied). 

Step 3. Add a Smart Styles element to the 
Library by using any of the methods described 
in chapter 7, Creating a Smart Styles Element.

48



49

11

Using Smart Styles to format whole text frames or 
individual text selections automates the formatting 
process. Format the page item once and then use 
it repeatedly to simplify the workflow process for 
preparing formatted ads, articles or chapters of 
publications, or to standardize the look of corpo-
rate publications and internal documents. The uses 
are unlimited, and Smart Styles makes it simple.

For everyday use, a full understanding of the working of 
Smart Styles is not necessary. Just creating an example 
will usually do the job without any special tweaking. For 
those who want to create more elaborate formatting 
with paragraph sequences of repeated styles, section 4. 
Paragraph Formatting and Sequences provides an over-
view of the recognition process used by Smart Styles.

1. Text Frame and Text Properties

Smart Styles Text Elements can be created from any 
page item that contains text. The text can be styled using 
InDesign’s type formatting features and subsequently 
converted into a Smart Styles element by dragging it into 
the Smart Styles Library. The following properties can be 
used separately or combined to style a text item.

• Columns (number, width, fixed width and 
gutter)
• Inset values
• First baseline settings
• Vertical justification values
• Ignore text wrap
• Optical margin alignment settings
• Text transparency

Character styles and paragraph styles are also rec-
ognized by Smart Styles, but these are treated in a 

special way. (For more information, see section 3. Using 
Character Styles and section 4. Paragraph section 4. 
Paragraph Formatting and Sequences.)

Creating a Text Element
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2. Creating a New Text Element

To create a new Smart Styles Text element, perform the 
following steps:

Step 1. Create a new page item, or use an 
existing page item such as a text frame.

Make sure that no object properties are 
applied since this will turn it into a com-

bined page/text element. Note however that any 
object formatting properties can always be dis-
abled via the Smart Styles Properties dialog box 
once the element is created. (For more informa-
tion, see chapter 8 Applying a Smart Styles 
Element – section 1, Applying Specific Element 
Properties.) 

Step 2. Use InDesign’s standard features to 
apply any of the properties listed above to the 
text (you are not limited to the number of prop-
erties that can be applied).

Step 3. Add a Smart Styles element to the 
Library by using any of the methods described 
in chapter 7, Creating a Smart Styles Element.

3. Using Character Styles

For each paragraph, Smart Styles will recognize a 
sequence of character styles at the start and the end of 
the paragraph. You can define nested styles inside your 
paragraph and they will automatically become part of the 
Smart Styles element. Smart Styles also offers an alterna-
tive or addition to nested styles—character styles—that 
are even easier to set up. You format one example, drag it 
into the Library, and it is ready to apply wherever needed.

Smart Styles analyzes the formatting changes within a 
paragraph and identifies each delimiter that signals a 
change to the formatting. 

A delimiter can either be:

• The last character of text formatted with a par-
ticular style.
• The first character of text formatted with a par-
ticular style.
• The character after the first or last space (for 
a two-character delimiter, useful for dashes). In 
general, all non-alphanumeric characters can 
be recognized as delimiters. 

Some delimiters are preferred over others: 

• Tab
• Line feed
• Comma
• Colon
• Dash (any type such as a dash, em dash, and 
so on)

For a complete list of preferred delimiters and their pre-
cedence, see appendix B, Delimiters.
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3.1  Understanding How Delimiters Work

Smart Styles determines the number of occurrences of a 
delimiter in styled text, allowing you to style the first or last 
words of a paragraph. If Smart Styles cannot determine 
which character serves as the delimiter in targeted text, 
it will use the number of styled characters in the Smart 
Styles element to determine how the style is applied. This 
allows you to style the first character of a paragraph or 
any other fixed number of characters. 

Once Smart Styles has identified all delimiters, it analyzes 
which ones are at the start of the paragraph and which 
are at the end. If the delimiter is closer to the start of the 
paragraph than to the end, it is considered to be part of 
the start sequence. In all other cases, it is considered to 
be part of the end sequence. 

When applying a Smart Styles element, the targeted 
paragraph is searched for delimiters that match 

those set in the definition of the original element. If a 
delimiter cannot be found, Smart Styles will skip the 
remainder of the sequence. 

When setting delimiters to use with a specific Smart 
Styles element, you can place the element that was used 
to create the definition onto the layout by dragging it from 
the Library while holding the Option key (Mac OS) or Alt 
key (Windows). With the original element on the page, you 
can examine how delimiters, and follow the same usage 
in the text to be formatted.

Three examples are given to demonstrate how this works.

In each example, hidden characters are displayed. To dis-
play hidden characters, choose Show Hidden Characters 
from the Type menu.
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Example 1

FIRST.TEXT.STYLE:.Second.text.style » Third.text.style#

A Smart Styles element with two delimiters (colon and tab).

In example 1, two delimiters are used. The first is a colon, 
and the second is a tab. The first delimiter is closer to 
the start of the paragraph, so it will be part of the start 
sequence. The tab is closer to the end and is therefore 
part of the end sequence. 

When this Smart Styles element is applied, the text up 
to the first colon will be styled bold, followed by roman 
text, and the text following the last tab will be styled italic. 
Without a delimiter to separate each character style 
sequence, Smart Styles cannot accurately recognize 
where to apply the correct formatting.

When creating a Smart Styles element for the 
Library, you can control the relative position of a 

delimiter by entering additional dummy text either before 
or after it, to insure that it formats the way you intended. 

Example 2

ARTIST﹕Title,.record.company#

2a. A Smart Styles element with two delimiters (white figure 
space and comma).

Joseph.P..Singer﹕Singer.of.Songs,.Music.Label¶ 
The.Songsters﹕Romantic.Tunes,.Sing-a-Long¶ 
Carole.Tune﹕Songs.for.the.Blues,.Blues.Tones#

2b. Unformatted text

Joseph P. Singer  Singer of Songs, Music Label 

The Songsters  Romantic Tunes, Sing-a-Long

Carole Tune  Songs for the Blues, Blues Tones

2c. Formatted text.

In example 2, a “white figure space” has been inserted 
after the ARTIST text style to act as the delimiter. This 
allows you to use normal spaces inside the ARTIST’s 
name (first and last names) without disturbing the for-
matting style. The second delimiter is a comma.

When this Smart Styles element is applied, all text before 
the first “white figure space” will be styled bold and red, 
followed by bold italic text. All text following the last 
comma will be styled in a smaller roman text.
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Example 3
Example 3 illustrates how to correctly set up a Smart 
Styles element that will accurately recognize and apply 
character style sequences separated by delimiters.

A semicolon (;) is used as the delimiter to separate the 
five numbered products. This delimiter is important to 
ensure that Smart Styles recognizes each character style 
sequence.

To obtain correct results, the Smart Styles element must 
be created with a number of repeating character style 
sequences that is equal to or greater than the number of 
sequences in the target item.

WoodWing Products¶
1..Smart.Styles;.2..Smart.Connection;.3..Content Sta-
tion;.4..Smart.Connection.;.5..Enterprise#

3a. Unformatted text includes a listing of five numbered prod-
ucts with a semicolon used as a delimiter between each	

WoodWing.Products¶
1..Smart.Styles;.1..Smart.Styles;.1..Smart.Styles; 

3b. Smart Styles element incorrectly set up: it contains only 
three repeating character style sequences (red number and 
black product)	

WoodWing Products
1. Smart Styles; 2. Smart Connection; 3. Content Sta-
tion; 4. Smart Connection; 5. Enterprise;

3c. When the incorrect Smart Styles element is applied to 
the unformatted text, only part of the text is formatted as 
expected.	

�

WoodWing.Products¶
1..Smart.Styles;.1..Smart.Styles;.1..Smart.Styles;. 
1..Smart.Styles;.1..Smart.Styles;.1..Smart.Styles;. 
1..Smart.Styles;.1..Smart.Styles;.1..Smart.Styles;#

3d. A Smart Styles element correctly set up with a greater 
number of repeating character style sequences than the tar-
get item.

WoodWing Products
1. Smart Styles; 2. Smart Connection; 3. Content Sta-
tion; 4. Smart Connection; 5. Enterprise;

3e. When the correct Smart Styles element is applied to the 
unformatted text, the results are correct.	
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4. Paragraph Formatting and Sequences

Smart Styles recognizes sequences of paragraph styles, 
letting you maximize its use in formatting stories that con-
tain repetitive paragraph styles within the body of text. 
Just follow the basic steps below to create a Smart Styles 
element that can be placed in the Library and applied 
to more complex text with repeating paragraph formats. 

A Smart Styles sequence is defined by creating an exam-
ple with dummy text that contains the desired formatting.

You can define sequences of paragraph formatting to be 
used by following this basic setup:

• Start Sequence: at the beginning of a story.
• In-between Sequence: as a repeating pat-
tern of paragraphs in-between the start and end 
sequence.
• End Sequence: at the end of the story.

The start and end sequences can consist of one or mul-
tiple paragraph styles. The in-between sequence can 
consist of any number of repeating patterns of paragraph 
styles.

4.1  Recognizing Paragraph Sequences

A Smart Styles sequence is defined by inserting simple 
paragraphs containing dummy text with the desired style. 
Table 4.1 shows how the concept works.

The following pages show examples of how to use this 
concept.

Table 4.1 Setting up a paragraph sequence
Sequence Step Action Apply to

Start Sequence 1 Set up the first paragraph(s) using the style for-
matting you want it to have.

From one to an infinite number of 
consecutive paragraph styles.

In-Between Sequence
2

Set up the second paragraph (one of the 
in-between paragraphs) with its own style 
formatting.

From one to an infinite number of 
repeating patterns of consecutive 
paragraph styles.

3 Copy the paragraph from step 2 and paste it as 
another paragraph so that it is duplicated exactly.

End Sequence 4 Format the last paragraph that ends the sequence. From one to an infinite number of 
consecutive paragraph styles.
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�Example 4
Example 4 shows a few of the possibilities for setting up a 
Smart Styles element to recognize paragraph sequences.

Smart.Styles.¶
AWARD-WINNING.SOFTWARE¶
from.WoodWing¶

Smart.Styles.delivers.powerful.formatting.capabilities.
to.InDesign.users.¶

Smart.Styles..delivers.powerful.formatting.capabilities.
to.InDesign.users.¶

Continued.On...#

4a. Setup of a Smart Styles element.

Smart.Styles.¶
Award-Winning.Software¶
from.WoodWing¶
Smart.Styles.delivers.powerful.formatting.capabilities.
to.InDesign.users..All.formatting.options.of.a.page.item,.
including.text.style.can.be.set.at.once.by.applying.a.Smart.
Style.element.from.the.Library.¶
Smart.Styles.makes.repetitive.formatting.much.more.
efficient,.saving.time.for.more.creative.tasks..Quality.
improves.by.using.Smart.Styles.for.repetitive.formatting.¶
Continued.on...#

4b. Unformatted, two-paragraph section of text.

Smart Styles 
Award-Winning Software
from WoodWing

Smart Styles delivers powerful formatting capabilities to 
InDesign users. All formatting options of a page item, 
including text style can be set at once by applying a Smart 
Styles element from the Library.

Smart Styles makes repetitive formatting much more 
efficient, saving time for more creative tasks. Quality 
improves by using Smart Styles for repetitive formatting.

Continued on ...

4c. After the Smart Styles element is applied to the two-para-
graph section of text.

Smart Styles 
Award Winning Software
from WoodWing

Smart Styles delivers powerful formatting capabilities to 
InDesign users. All formatting options of a page item, 
including text style can be set at once by applying a Smart 
Styles element from the Library.

Smart Styles makes repetitive formatting much more 
efficient, saving time for more creative tasks. Quality 
improves by using Smart Styles for repetitive formatting.

Smart Styles delivers powerful formatting capabilities to 
InDesign users. All formatting options of a page item, 
including text style can be set at once by applying a Smart 
Styles element from the Library.

Smart Styles makes repetitive formatting much more 
efficient, saving time for more creative tasks. Quality 
improves by using Smart Styles for repetitive formatting.

Continued on ...
4d. After the Smart Styles element is applied to a four-para-
graph section of text.
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In example 4, the Smart Styles element is made up of a 
start sequence that consists of three differently styled 
paragraphs (the headlines).

The in-between sequence consists of two paragraphs 
with identical formatting. They have been copied and 
pasted to ensure that they are exactly the same. 

The end sequence consists of one line with entirely dif-
ferent formatting.

This simple Smart Styles element setup can be applied 
to any length of copy that has three differently formatted 
paragraphs at the beginning, a differently formatted para-
graph at the end, and any number of paragraphs with the 
same formatting in between. 

To create the Smart Styles element setup, the actual copy 
is used to format each paragraph until the desired format-
ting is achieved. 

The original heads are used in the setup to represent the 
start sequence, but just parts of each headline could have 
been used as well, as long as the individual paragraph 
breaks and formatting are represented for each style. 

Only one of the in-between paragraphs is used to cre-
ate the setup. It is copied and pasted to ensure that the 
two paragraphs for the in-between styles are exactly the 
same.

In-between paragraphs are defined by using the 
same sequence of paragraph and character styles 

and their attributes, for two (or more) consecutive para-
graphs. In order to be considered the same by Smart 
Styles, the paragraphs must be exactly the same. The 
best way to insure this is to style one paragraph and then 
copy and paste it into position as the second 
paragraph. 

Example 5
Example 5 shows four different setups that illustrate 
the principle of the Smart Styles sequence recognition 
system. 

A Smart Styles sequence setup can have an unlim-
ited number of paragraphs with different styles in 

both the start and end sequence.

Example 5a
• Start sequence: three paragraphs with dif-
ferent styles.
• In-between sequence: three repeated sets 
of two paragraphs with different styles each.
• End sequence: two paragraphs with differ-
ent styles.

START.STYLE.1¶
START.STYLE.2¶
START.STYLE.3¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶

END.STYLE.1¶
END.STYLE.2–LAST#
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Example 5b
• Start sequence: four paragraphs with differ-
ent styles.
• In-between sequence: six repeated sets of 
two paragraphs with different styles each.
• End sequence: four paragraphs with differ-
ent styles.

START.STYLE.1¶
START.STYLE.2¶
START.STYLE.3¶
START.STYLE.4¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶

END.STYLE.1¶
END.STYLE.2¶
END.STYLE.3¶
END.STYLE.4–LAST#

Example 5c
• Start sequence: five paragraphs with differ-
ent styles.
• In-between sequence: three repeated sets 
of three paragraphs with different styles each.
• End sequence: six paragraphs with different 
styles.

START.STYLE.1¶
START.STYLE.2¶
START.STYLE.3¶
START.STYLE.4¶
START.STYLE.5¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.C¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.C¶
IN-BETWEEN.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.C¶

END.STYLE.1¶
END.STYLE.2¶
END.STYLE.3¶
END.STYLE.4¶
END.STYLE.5¶
END.STYLE 6-LAST#
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Example 5d
Smart Styles searches for the longest repeat-
ing sequence of paragraph styles for the 
in-between sequence. A text frame using the 
paragraph style sequence A-B-B-C-B-B-C-D 
will use B-B-C as the repeating sequence, not 
B.

START.STYLE.A¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.C¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.B¶
IN-BETWEEN.STYLE.C¶
END.STYLE.D#

Example 6
Example 6 on the next page illustrates how Smart Styles 
recognizes and applies patterns of repeated formatting to 
the in-between sequence. �Example 6a shows the Smart 
Styles element setup for the Events calendar in Example 
6c. It contains two paragraphs in the start sequence, five 
repeated patterns in the in-between sequence and four 
paragraphs in the end sequence.
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Start.Head-1¶
Start.Subhead-2¶

In-Between.Format-1¶
In-Between.Format-2¶
In-Between.Format-3¶
In-Between.Format-1¶
In-Between.Format-2¶
In-Between.Format-3¶
In-Between.Format-1¶
In-Between.Format-2¶
In-Between.Format-3¶
In-Between.Format-1¶
In-Between.Format-2¶
In-Between.Format-3¶
In-Between.Format-1¶
In-Between.Format-2¶
In-Between.Format-3¶
End.Copy-1¶
End.Copy-2¶

End.Copy-3¶
End.Copy-4#

6a. The formatted Smart Styles 
element.

Events.of.the.Year¶
Updated.Weekly¶
Sleigh.Rides¶
Book.in.advance.for.guarantee.
of.seating.¶
Santa.Rides¶
Valentine.Dance¶
Bring.your.own.date.and.
be.prepared.to.have.a.good.
time.¶
Hearts.Aflame¶
Flower.Exhibit¶
Early.spring.flowers.from.
around.the.world.will.be.on.
exhibit.from.10:00.-.5:00.¶
Dancing.in.the.Rain.Ball¶
Gala.event¶
Includes.cocktails,.dinner.
and.a.full.night.of.dancing.
to.the.music.of.Taholla.¶
The.Taholla.Band¶
Yearly.Dog.Show¶
All.pets.are.welcome..Winners.
will.receive.free.dog.food.¶
Barkalot.Dog.Food¶
Watch.for.updates.¶
Call.with.new.events.¶
Ask.for.the.editor.¶
All.newcomers.welcome#

6b. Unformatted text

Events of the Year
Updated Weekly

Sleigh Rides
Book in advance for guarantee of 
seating.
Santa Rides
Valentine Dance
Bring your own date and be pre-
pared to have a good time.
Hearts Aflame
Flower Exhibit
Early spring flowers from around 
the world will be on exhibit from 
10:00 - 5:00.
Dancing in the Rain Ball
Gala event 
Includes cocktails, dinner and a full 
night of dancing to the music of 
Taholla.
The Taholla Band
Yearly Dog Show
All pets are welcome. Winners will 
receive free dog food.
Barkalot Dog Food
Watch for updates.
Call with new events.

Ask for the editor.
All newcomers welcome

6c. Formatted text after applying Smart Styles 
element 6a.
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Example 7
Examples 7a, 7b and 7c show the flow and results of 
applying a Smart Styles element to unformatted text that 
has exactly the same number of lines as the Smart Styles 
element. All changes in formatting are recognized and 
applied correctly.

7a. The format-
ted Smart Styles 

element

WoodWing Products¶
Multichannel publishing:¶
Smart Connection¶
Content Station¶
Digital asset management:¶
Elvis DAM¶
Elvis Brand portal¶
WoodWing is based in The Netherlands#

7b. Unformatted 
text

WoodWing Products¶
Multichannel publishing:¶
Smart Connection
Content Station
Digital asset management:¶
Elvis DAM
Elvis Brand portal
WoodWing is based in The Nether-
lands#

7c. The targeted 
text after the 

Smart Styles ele-
ment is applied

WoodWing Products¶
Multichannel publishing:¶
Smart Connection¶
Content Station¶
Digital asset management:¶
Elvis DAM¶
Elvis Brand portal¶
WoodWing is based in The Netherlands#

In Example 7d, an additional line of copy (Pro client) is 
added under the heading “Digital asset management:” 
and the same Smart Styles element is applied. The for-
matting remains correct. This is because Smart Styles 
interprets the number of lines of copy beneath “Digital 
asset management:” as being variable.

7d. An additional 
line is added 

under the ‘For 
InCopy:’ heading 

and the same 
Smart Styles ele-

ment is applied

WoodWing Products¶
Multichannel publishing:¶
Smart Connection¶
Content Station¶
Digital asset management:¶
Elvis DAM¶
Elvis Brand portal¶
Pro client
WoodWing is based in The Netherlands#

In Example 7e however, when an additional line of 
copy (Enterprise Server) is added under the heading 
“Multichannel publishing:” and the same Smart Styles 
element is applied, the formatting does not appear as 
originally intended since the added product is now styled 
in red. 

7e. An additional 
line is added 

under the ‘For 
InDesign:’ head-

ing and the same 
Smart Styles ele-

ment is applied

WoodWing Products
Multichannel publishing:
Smart Connection
Content Station
Enterprise Server
Digital asset management:
Elvis DAM
Elvis Brand portal
WoodWing is based in The Netherlands

In order to correct this problem, the original Smart 
Styles element must be modified so that each part of the 
sequence that can be of variable length will be recognized 
by Smart Styles as one block in the sequence. This can 
be done by changing the end of the lines with a variable 
length from a normal line break to a soft line break (key-
board shortcut Shift-Enter). (See figure 7f.)
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The same construction must be valid for both the 
Smart Styles element and the targeted text. By fol-

lowing this procedure, you can make several blocks with 
variable length that will be formatted correctly by Smart 
Styles.

7f. The formatted Smart 
Styles element with modi-

fied line endings

WoodWing Products¶
Multichannel publishing:¶ 	 (normal line break)

Smart Connection ¬ 	 (soft line break)

Content Station¬	 (soft line break)

Enterprise Server¶	 (normal line break)

Digital asset management:¶	 (normal line break)

Elvis DAM¬	 (soft line break)

Brand portal¶	 (normal line break)

WoodWing is based in The Netherlands#

7g. The unformatted text 
with modified line endings

WoodWing Products
Multichannel pubilshing: ¶ 	 (normal line break)

Smart Connection ¬ 	 (soft line break) 
Content Station ¬ 	 (soft line break) 
Enterprise Server¬ 	 (soft line break) 
Digital asset management: ¶ 	 (normal line break)

Elvis DAM¬ 	 (soft line break) 
Brand portal ¬ 	 (soft line break) 
Pro client¶ 	 (normal line break)

WoodWing is based in The Netherlands

7h. The Smart Styles ele-
ment applied, now with 

correct results

WoodWing Products
Multichannel publishing:
Smart Connection 
Content Station 
Enterprise Server
Inception
Digital asset management:
Elvis DAM 
Brand portal 
Pro client
WoodWing is based in The Netherlands
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Smart Styles not only lets you quickly format a 
table but also allows you to sort the data or insert 
formulas into cells, turning your static tables into 
dynamic spreadsheets. 

Sorting data and using formulas is also functional 
in InCopy (when in Layout view mode).

This chapter explains how to format tables and how to use 
the sorting and formula features of Smart Styles.

1. Table Element Properties

The following properties can be used to style a Smart 
Styles table element, either separately or combined:

• Table Options: table border, table spacing, 
row strokes, column strokes and fills, headers 
and footers.

• Cell Options: cell inset, vertical justification, 
first baseline settings, clipping, rotation, cell 
strokes, cell fills, row height, column width, keep 
options and diagonal lines. 

• Text Style: for each cell, Smart Styles will use 
its full text styling capabilities. (For more informa-
tion, see chapter 11, Creating a Text Element.)

Working With Tables
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2. Creating a New Table Element

To create a new Smart Styles table element, do the 
following:

Step 1. Create a text frame containing a table.

Step 2. Format the table using InDesign’s 
formatting features (you are not limited to the 
number of properties that can be applied).

Step 3. Select the text frame and add it to the 
Library using any of the methods described in 
chapter 11, Creating a Text Element.

3. How Sequences Are Recognized

All attributes of a table are set automatically by Smart 
Styles. When applying a table element, the system ana-
lyzes the sequence of formatting in both horizontal and 
vertical directions. This allows specific formatting for the 
first row (or series of rows), an “every other row” rhythm 
style after the first row, and again a different style for the 
last row (or series of rows). 

Because Smart Styles analyzes this for both the rows and 
columns, you can set up a very powerful Smart Styles 
table element to simplify the process of formatting numer-
ous tables consistently.

The concept of sequencing is as simple as 1,2,3:

1. Equals the start sequence.
2. Equals the in-between sequence.
3. Equals the ending sequence.

The start and end sequences can each contain any num-
ber of rows with different formatting applied to each row. 
The in-between sequence can also contain any number 
of repeating rows. Your formatting will reflect how these 
in-between rows are set.

To explain this concept, review the examples on the fol-
lowing pages.
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Example 1
In example 1, compare the unformatted Table 1a with 
the formatted Table 1b to see the results of applying the 
Smart Styles table element shown in Table 1c.

In formatted Table 1b, the first and second rows are styled 
differently. Smart Styles recognizes this as a two-row start 
sequence. 

The in-between rows are formatted identically, and are 
recognized as a repeated pattern. 

The last row is formatted differently, defining it as an end 
sequence.

In this example, the repeating sequence consists of a 
single style, but it could be any number of repeated styles.

If you have two different rows of a repeating style, you 
must duplicate those two rows exactly in your initial setup 
so that Smart Styles can determine which rows belong to 
the repeating in-between sequence.

Once this table is formatted properly and dropped into 
the Smart Styles Library, it will work to format a table 
consisting of any number of rows.

The same sequencing concept applies to columns. In 
table 1b, there are four columns: a start sequence (the first 
two columns), an in-between sequence (the third column) 
and an end sequence (the fourth column).

Several text and paragraph styles as well as text 
frame insets are used in this example. These are all 

recognized by Smart Styles when applying formatting.

The same basic principles of sequencing apply to 
both paragraphs and tables. It will be helpful to 

review chapter 11, Creating a Text Element – section 4, 
Paragraph Formatting and Sequences, to understand 
how Smart Styles recognizes sequences.

last week weeks on chart

1 — backstreet boys Black & Blue 1

2 1 The beatles 1 2

3 2
various artists NOW That’s What I 
Call Music! 2

4 — tim mcgraw Greatest Hits 1

5 — Wu-tang clan The W 1

6 3 sade Lovers Rock 2

7 5 R kelly TP-2.com 3

©2000 BPI COMMUNICATIONS INC./SOUNDSCAN INC. USED WITH PER-
MISSION FROM BILLBOARD, DEC. 9, 2000

1a. An unformatted table

L A S T 
WEEK

WEEKS 
ON 

CHART

1 — BACKSTREET BOYS Black & Blue 1

2 1 THE BEATLES 1 2

3 2 VARIOUS ARTISTS NOW That’s What I Call Music! 2

4 — TIM MCGRAW Greatest Hits 1

5 — WU-TANG CLAN The W 1

6 3 SADE Lovers Rock 2

7 5 R KELLY TP-2.com 3
©2000 BPI COMMUNICATIONS INC./SOUNDSCAN INC. USED WITH 

PERMISSION FROM BILLBOARD, DEC. 9, 2000

1b. The table formatted with the Smart Styles element shown 
in 1c.

HEAD HEAD Start sequence
1 — ARTIST Title 1

1 — ARTIST Title 1 In-between 
sequence1 — ARTIST Title 1

1 — ARTIST Title 1
NEW UPDATE INFORMATION End sequence

1c. The Smart Styles table sequencing pattern used to format 
table 1b.
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Example 2
Example 2 illustrates the ability to set up entire text frames 
of formatting, including tables and text. 

Table 2a shows a text frame before formatting.

Table 2b (on the next page) shows the text frame after 
the Smart Styles table element (created from table 2c) 
is applied.

Table 2c (on the next page) shows the setup for sequenc-
ing that was saved as a Smart Styles element.

In this case, Smart Styles table element 2c is dragged 
onto the text frame, outside any tables. If this is applied 
directly to a table within the text frame, only that one table 
is formatted with the first table format in the element (the 
green table).

The text in table 2b also provides further information 
on creating the Smart Styles table element shown 

in table 2c.

This example contains a Headline
It also contains a paragraph of formatted text at the 
top followed by a table.

This is another paragraph of differently formatted 
text between the tables.

This is another paragraph of differently formatted 
text between the tables.

If you need to repeat this pattern of three tables with 
text in-between, you must copy and paste the entire 
section, including the first table and this paragraph, 
directly beneath this paragraph so that Smart Styles 
will recognize this as a repeating pattern. 
However, if this can be used as is to style your text 
frames within a document, this last paragraph of 
formatted text represents the end sequence, with no 
characters or spaces after the last period.

Table 2a. A text frame containing text and three tables before 
formatting.
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Table 2b. The text frame with differently formatted tables after 
applying the Smart Styles element shown in table 2c.

This example contains a Headline
IT ALSO CONTAINS A PARAGRAPH 
OF FORMATTED TEXT AT THE TOP 
FOLLOWED BY A TABLE.

THIS IS ANOTHER PARAGRAPH OF DIFFERENTLY 
FORMATTED TEXT BETWEEN THE TABLES.

THIS IS ANOTHER PARAGRAPH OF DIFFERENTLY 
FORMATTED TEXT BETWEEN THE TABLES.

IF YOU NEED TO REPEAT THIS PATTERN OF 
THREE TABLES WITH TEXT IN-BETWEEN, 
YOU MUST COPY AND PASTE THE ENTIRE 
SECTION, INCLUDING THE FIRST TABLE AND 
THIS PARAGRAPH, DIRECTLY BENEATH THIS 
PARAGRAPH SO THAT SMART STYLES WILL 
RECOGNIZE THIS AS A REPEATING PATTERN. 
However, if this can be used as is to style your text frames 
within a document, this last paragraph of formatted text 
represents the end sequence, with no characters or spaces 
after the last period.

Table 2c. The formatted Smart Styles element.

Headline
PARAGRAPH ABOVE FIRST TABLE.

PARAGRAPH ABOVE SECOND TABLE.

PARAGRAPH ABOVE THIRD TABLE.

PARAGRAPH BELOW THIRD TABLE.
End paragraph.

66



Chapter 12  Working With Tables

4. Using Formulas

Smart Styles allows you to make calculations by applying 
formulas to the contents of cells, very much like working 
with a spreadsheet application. 

This feature is also functional in InCopy.

Note that this functionality does not leave a ‘footprint’ in 
the document. Documents that contain tables with formu-
las applied can easily be opened with versions of InDesign 
or InCopy that do not have Smart Styles installed. The 
values of the formulas are displayed as regular text and 
can be edited as normal.

The following sections explain how to work with formulas 
using Smart Styles.

4.1  The Interface

Smart Styles adds the following components to the 
InDesign and InCopy interface for working with formulas:

• Table menu commands
• A Formula dialog box

Each component is explained in the following sections.
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4.1.1 Menu Commands

A submenu named Formula is added to the InDesign/
InCopy Table menu, containing commands for inserting, 
updating, and highlighting formulas.

The submenu contains the following commands:

• Insert.... Opens the Formula dialog box for 
inserting a formula. See section 4.2 Inserting 
Formulas.

• Update. Updates the formula in the active cell 
or a selection of cells. See section 4.3 Editing 
Formulas.

• Update All. Updates all formulas in the active 
document. See section 4.3 Editing Formulas.

• Show Fields/Hide Fields. By default, the 
value of a formula within a cell is highlighted in 
orange. This menu option allows you to show or 
hide the highlighting.

The same commands are also available in the con-
text menu when right-clicking a cell or table. 

The Update and Update All commands will only be 
available when formulas exist in the table. Also, the 

Update command is only available when the cursor is 
placed in the formula value in a cell and not when placed 
in any other part of the cell. The Update All option is 
always available, even when the cursor is not placed in a 
table or when no selections are made. 

4.1.2 The Formula Dialog Box

The Formula dialog box is used for adding a formula 
to a cell and for determining the way it is automatically 
formatted.

Figure 4.1.2 The Formula dialog box

A   Formula entry box  B   Number format list
C   Insert function list  D   Syntax example area

A

B

C D

For more information about using the Formula dialog box, 
see section 4.2 Inserting Formulas.
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4.2  Inserting Formulas

To insert a formula in a cell, perform the following steps:

Step 1. Place the text cursor in the cell in which 
the formula needs to be inserted.

Step 2. Do one of the following:

• From the Table menu, choose Formula 
followed by Insert.

• Right-click on the cell or table and choose 
Formula followed by Insert.

The Formula dialog box appears (See figure 
4.1.2 on the previous page.)

Step 3. In the Formula entry box, manually 
enter a formula (see also Step 5). 

For more information about the structure 
of a formula, see appendix D, Working with 
Formulas.

Step 4. (Optional) From the Number Format 
list, select one of the default formats, or enter 
your own format. 

Step 5. (Optional) From the Insert Function 
list, select a function to be added to the formula 
in the Formula box. The function is inserted 
at the point where the cursor is placed in the 
Formula box.

The following default functions are available in 
the list (other functions are supported as well):

• ABS(). Absolute
• Avarage(). Avarage
• Int(). Integer
• Product(). Product
• Round(). Round

• Sum(). Sum

For more information about functions including examples, 
see appendix D, Working with Formulas.

After selecting a function from the list, the Syntax 
Example area shows an example of the syntax that 

needs to be used for the chosen function.

Step 6. Click OK to insert the formula. 

In case the syntax or format has been entered 
incorrectly, a message appears. (For more 
information, see section 4.2.1 Troubleshooting 
Formulas.)

By default, the formula will appear highlighted in orange 
(when viewing the layout in InDesign’s Normal display 
mode or InCopy’s Layout view). 

This highlighting can be switched on or off by 
choosing Show Fields/Hide Fields from the 

Formula submenu in the Table menu or the context menu.

23 45

68
Figure 4.2 By default, formula values in 
cells are highlighted in orange
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4.2.1 Troubleshooting Formulas

When setting the syntax or formatting in the Formula dia-
log box and subsequently clicking OK, Smart Styles may 
warn you if an incorrect entry has been made.

• In case the entered syntax or the cell range in 
the Formula entry box is incorrect, a message 
appears indicating that the formula cannot be 
inserted:

Unable to insert the formula due to an error in 
the formula syntax.

Close the message to return to the Formula dia-
log box and verify the entered syntax for any 
mistakes.

• In case the entered format in the Number 
Format list of the Formula dialog box is incor-
rect, Smart Styles will display a message when 
clicking OK, indicating that the formula cannot 
be inserted. 

Unable to insert the formula due to an error 
in the format syntax.

Close the message to return to the Formula 
dialog box and verify the entered format for any 
mistakes.

• #error is displayed in the cell when the cell-
range in the formula refers to non-existing cells 
or columns, or those that are not allowed (cells 
in headers and footers).

4.3  Editing Formulas

To edit an entered formula, perform the following steps:

Step 1. In the cell that holds the formula, place 
the cursor in the formula value (highlighted in 
orange by default).

Step 2. Do one of the following:

• From the Table menu, choose Formula, 
followed by Edit.

• Right-click on the cell or table and from 
the context menu choose Formula, fol-
lowed by Edit.

The Formula dialog box appears (See figure 
4.1.2.)

Step 3. Make the changes as needed. (See 
section 4.2 Inserting Formulas.)

Step 4. Click OK to insert the formula. (See 
also section 4.2.1 Troubleshooting Formulas.)
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4.4  Updating Formulas

Whenever values of cells that are referenced by one or 
more formulas are changed, the formulas need to be 
updated in order to reflect these changes. 

Update the formulas regularly or at least as the final 
step when finished working on the table so that the 

correct values are displayed.

Formulas can be updated individually, by range or by 
document, as explained in the sections on the following 
pages.

When updating formulas, any manually applied 
number formatting will be replaced by the format-

ting rules as set in the Formula dialog box (if any).

4.4.1 Updating Formulas Individually

To update an individual formula, perform the following 
steps:

Step 1. In the cell that holds the formula, place 
the text cursor in the formula value (highlighted 
in orange by default).

Step 2. Do one of the following:

• From the Table menu, choose Formula, 
followed by Update.

• Right-click on the cell or table and from 
the context menu choose Formula, fol-
lowed by Update.

The value of the formula is updated 
automatically.
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4.4.2 Updating Formulas By Range

To update all formulas in a range of cells, perform the 
following steps:

Step 1. Select a range of cells that hold 
formulas.

Step 2. Do one of the following:

• From the Table menu, choose Formula, 
followed by Update.

• Right-click on the cell or table and from 
the context menu choose Formula, fol-
lowed by Update.

The value of the formula is updated 
automatically.

4.4.3 Updating Formulas By Document

To update all formulas in a document, do the following:

• From the Table menu, choose Formula, fol-
lowed by Update.

The Update Formula command is always available, 
it is not necessary to first place the text cursor in a 

table or make any kind of selections.
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4.5  Copying Formulas

Formulas can be copied from one cell to another cell, just 
as any other regular text. 

The syntax of the pasted formula will be adjusted 
to its new location. For example: when copying the 

formula =SUM(A1+A3) from cell A5 to cell B5, the pasted 
formula will now be =SUM(B1+B3).

5. Sorting Tables

Smart Styles allows you to sort tables by text, numbers, 
range, and case sensitivity. Since each language has got 
its own very specific sorting rules, the language rules that 
the sorting engine needs to follow can also be selected. 
Of course tables can also be sorted in ascending or 
descending order. 

This feature is also functional in InCopy (when in 
Layout view mode).
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5.1  The Interface

Smart Styles adds the following components to the 
InDesign and InCopy interface for working with formulas:

• Table menu command
• A Sort dialog box

Each component is explained in the following sections.

5.1.1 Table Menu Command

A command named Sort... is added to the Table menu. 
Choosing this command will bring up the Sort dialog box. 
(See section 5.1.2 The Sort Dialog box.)

The Sort command is also available in the context 
menu when Right-clicking a cell or table.

The Sort command is only available when the cur-
sor is placed inside a table.
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5.1.2 The Sort Dialog Box

The Sort dialog box provides various settings for sorting 
a table.

Figure 5.1.2 The Sort dialog box

A   Column sorting options  B   Sorting range options
C   Language list  D   Case sensitive check box
E   Value type list  F   Ascending/descending options

A

B

C

E F

D

The Sort dialog box is divided into three main sections:

Sort by
This section is used to indicate the sequence and the 
way the column(s) need to be sorted. It holds the follow-
ing options:

• Column list. From this list, choose the column 
which needs to be sorted first. The list refers to 
columns in the following way:

• For tables that contain a header: either the 
content of the header is shown (including 
an empty value when the header is empty) 
or Column[number] if no value has been 
entered yet.
• For tables not containing a header: 
Column[number] is shown. 
As soon as a choice has been made, the 
Type and sorting order options become 
available.

• Type list. From this list, define if the column 
contains (mainly) textual or numeric data.
• Ascending/descending options. Choose 
whether the data needs to be sorted in ascend-
ing or descending order.

Sorting Range
Defines what section of the table needs to be sorted:

• Whole Table (all columns and rows)
• Column Only (only the column where the text 
cursor is placed into)
• Selection On�ly (only the selected cells)

When the Selection Only option is used, the column 
sorting options are used only when applicable. For 

instance, when cells in only one column are selected, only 
those cells are sorted even when sorting settings for two 
or more columns are set.

Language
Different languages have different ways of sorting. 
Choose the appropriate language from the language list 
in order to ensure correct sorting results. 

Smart Styles automatically sets the language according 
to the following rules:

• Cursor placed in text: the language of that 
word

75



Chapter 12  Working With Tables

• Selected text: the first language that occurs 
in the text
• Selected table: the first language that occurs 
in the table

In addition, select the Case Sensitive check box if case 
sensitivity is required.

5.1.3 Troubleshooting Sorting Tables

When cells have been selected on which Smart Styles is 
not able to sort the data, a message is displayed.

• When cells are selected that have been split or 
merged, Smart Styles will display a message:

Cannot sort the table containing split or 
merged row cells.

• In situations where columns have been 
selected containing merged cells that span 
other (unselected) columns, Smart Styles will 
display a message:

Cannot sort the table containing split or 
merged row cells.
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Smart Styles can be easily integrated with 
WoodWing Smart Connection: a set of plug-ins 
for InDesign and InCopy for communicating with 
Enterprise Server. 

This chapter explains the additional functionality of using 
Smart Styles within a Smart Connection environment.

1. Articles and Element Labels

Smart Connection makes use of the article concept. 
An article typically consists of different components: 
headline, intro, body text, and so on. Each of these com-
ponents can be made up of separate frames and treated 
as a separate object in which each component is fully 
editable. To each article component, a label is assigned 
to indicate its purpose (or intent). For example: labeling a 
text frame with the label Headline and another text frame 
with the label Body Text, makes it clear to all users what 
the purpose of these frames is: editors will know what 
type of content to add and designers will know how to 
format and position that content.

Smart Styles offers additional functionality when used in 
combination with Smart Connection by making use of 
the Element Label feature of Smart Connection and the 
Article feature of InDesign.

Smart Styles and Smart Connection
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2. The Element Label Panel

With Smart Connection installed, the Element Label panel 
can be used to label article components. 

Normally Smart Styles will not be able to match the 
components of a Smart Styles element to a target with 
multiple components. Smart Styles will use the proper-
ties of one Smart Styles component and apply them to 
all items of the target. However, when both the Smart 
Styles components and the target article components are 
labeled, Smart Styles will use these labels to match the 
Smart Styles elements with the target items. 

For example: the properties of the head component in 
the Smart Styles element will be applied to the head 
component of the target item; the properties of the body 
component in the Smart Styles element will be applied to 
the body component of the target, and so on. 

If a target component cannot be matched to a com-
ponent in the Smart Styles element, the properties 

of the target component will not be changed.

Take note of the following exceptions:

• If you have one component in your Smart 
Styles element and you apply this to one target 
component, the target component will always 
be styled according to the Smart Styles ele-
ment, regardless of their Element Labels. (The 
Element Label will not be changed though). 

• If you are using the same element labels more 
than once in your Smart Styles, only one of 
these items will be used for applying the style.
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3. InDesign Articles

When working in a Smart Connection environment, 
articles are made up of multiple text frames, each rep-
resenting a different component such as ‘head’, ‘intro’, 
‘body’ and so on. To identify each frame as a separate 
component, an Element Label is applied.

In order to treat these separate frames as one article, they 
are combined into an InDesign Article by using the Articles 
panel (Window > Articles). 

For more information about InDesign Articles, see 
the InDesign Help: Articles.

Smart Styles is able to recognize such multi-component 
InDesign Articles and correctly format each component.

The process is as follows:

Step 1. Create a separate frame for each arti-
cle component and apply the correct label by 
using the Element Label panel (Window > Smart 
Connection > Elements).

Step 2. Apply styling to the frame and/or the 
content of the frame.

Step 3. Access the Articles panel by choosing 
Window > Articles.

Step 4. Drag the frames onto the panel (or click 
the ‘+’ icon), type a name and click OK.

An InDesign article is created containing the selected 
frames.

Step 5. Turn the selected frames into a Smart 
Styles element.

Step 6. Drag the Smart Styles element onto 
any of the frames of an InDesign Article to style 
it.

How Smart Styles applies the correct format-
ting
Smart Styles looks for text frames in the InDesign Article 
that have the same Element Label applied as a text frame 
in the Smart Styles element. When found, it applies the 
styling of the component in the Smart Styles element to 
the component in the InDesign Article.

Example: a Smart Styles element containing the com-
ponents ‘head’, ‘intro’ and ‘body’ is dropped onto any 
of the frames of an InDesign Article that also contains 
the components ‘head’, ‘intro’ and ‘body’. As a result, 
each component in the InDesign Article is styled with 
the corresponding style of the component in the Smart 
Style element: ‘intro’ with ‘intro’, ‘head’ with ‘head’ and 
‘body’ with ‘body’.

Various variations of this scenario exist but the general 
rule is that as long as frames with matching Element labels 
are found then the component in the InDesign Article is 
styled with the style from the component in the Smart 
Styles element.

One exception exists when the Smart Styles element con-
sists of only one component. When dragging such an 
element onto a single InDesign Article component on the 
layout, the component is directly styled without verifying 
if they have matching Element Labels.

Chapter 13  Smart Styles and Smart Connection
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A

This appendix describes Smart Styles’ additions to 
InDesign’s scripting object model. (Knowledge of 
InDesign scripting is required.)

1. Javascript

Smart Styles extends the Asset and Library object. 

Additional asset method:
• Property: applySmartStyle
• Parameters: Selection or (list of) PageItem(s)
• Returns: nothing
• What it does: Applies the asset as Smart 
Styles to the page item(s)

// This example applies the first item of the first library as Smart
// Style to the first page item of the active document
var myLib = app.libraries.item(0).assets.item(0);
var myItems = [app.activeDocument.pageItems.item(0)];
myLib.applySmartStyle( myItems );

Additional library property:
• Property: smartStyles
• Value type: Boolean
• Access: read/write
• What it is: Toggles the library between an 
Object and Smart Styles library 

// The script toggles the first library from Smart Styles to
// Object library or the other way around
if( app.libraries.item(0).smartStyles == false )

app.libraries.item(0).smartStyles = true;
else

app.libraries.item(0).smartStyles = false;

Scripting

80



81

B

The number of characters recognized as delimiter 
in Smart Styles is limited. This appendix gives an 
overview of the allowed and preferred delimiters. 

1. Allowed Delimiters

Table 1 shows the delimiters that can be used in Smart 
Styles. 

Table 1. Allowed delimiters
Unicode symbol Remark
0x0007 - 0x0009 Tabs 
0x000A Line feed 
0x0021 - 0x002F ! “ # $ % & ’ ( ) * + , - . / 
0x003A - 0x0040 : ; < = > ? @ 
0x005B - 0x0060 [ \ ] ^ _ ` 
0x007B - 0x007E { | } ~ 

0x00A1 - 0x00BF ¡ ¢ £ ¤ ¥ ¦ § “ © a « ¬ ® o ± 2 3 ’ μ ¶ · ‚ 
1 ° » 1 ⁄2 1 ⁄4 3⁄4 ¿

0x200C - 0x20CF Various symbols 
0x2500 - 0x27BF Box, block and other symbols 
0x3000 - 0x3002 Japanese normal space
0xE000 Inline items 

0xFE35 - 0xFE44 ⌢⌣︹︺︷︸︿﹀︽︾ 
﹁﹂﹃﹄︻︼

(Continues on next page)

Delimiters
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Table 1. Allowed delimiters (continued)
Unicode symbol Remark

0xFE50 - 0xFE6F Various symbols 
0xFF08 - 0xFF09 ( )
0xFF0B - 0xFF0F + , - . /
0xFF1A - 0xFF1A : ;
0xFF1F ?
0xFF01 !
0xFFE5 ¥
0xFF03 #
0xFF3B [
0xFF3D ]
0xFF5B {
0xFF5D }
0x0020 Normal space 
0x2000 - 0x200B Special spaces 

0x203B ※
0x00A0 Hard space 
0x3008 - 0x3011 < > � ������ �

0x3014 - 0x3015 ［ ］
0x30FB •

2. Preferred Delimiters

A number of delimiters have preference over other delimit-
ers. This means that if two possible delimiters are found 
and one of them is preferred, the preferred delimiter will 
be used. 

Table 2. Preferred delimiters
Unicode symbol Remark 
0x0007 - 0x0009 Tabs 
0x000A Line feed 
0x002C Line feed 
0x003A Line feed
0x2010 - 0x2015 Dashes
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The following overview describes each of the Smart 
Style item properties—as available in the Smart 
Styles Properties dialog box—and indicates which 
property a page item is affected when applied.

The overview is divided into the three main property 
groups: 

1. Object Style
2. Text Style
3. Table Style

For more information about these properties, see 
InDesign Help or InCopy Help.

1. Object Style

InDesign Object Style—InDesign Object Style. Off 
by default

Stroke Settings
Color—Stroke color
Tint—Stroke tint
Overprint—Overprint Stroke attribute
Weight—Stroke weight
Cap, Join, Miter—Cap, Join, Miter settings
Line Type, Start, End—Line Type, Start, End settings
Corner Options—Corner options
Gap: Color, Tint, Overprint—Gap options
Alignment—Alignment options
Gradient—Stroke gradient settings
Transparency Effect Settings

Transparency—Transparency settings
Drop Shadow—Drop shadow settings
Inner Shadow—Inner shadow settings
Outer Glow—Outer glow settings
Inner Glow—Inner glow settings
Bevel and Emboss—Bevel and emboss settings
Satin—Satin settings
Feather—Feather settings
Directional Feather—Directional Feather settings
Gradient Feather—Gradient feather settings

Smart Styles Element Properties
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Fill settings
Color—Fill color 
Tint—Fill tint
Overprint—Overprint Fill attribute
Gradient—Fill gradient settings
Transparency Effect Settings

Transparency—Transparency settings
Drop Shadow—Drop shadow settings
Inner Shadow—Inner shadow settings
Outer Glow—Outer glow settings
Inner Glow—Inner glow settings
Bevel and Emboss—Bevel and emboss settings
Satin—Satin settings
Feather—Feather settings
Directional Feather—Directional Feather settings
Gradient Feather—Gradient feather settings

Nonprinting—Nonprinting attribute

Interactive Settings
Animation—Animation settings
Media—Media settings

Transparency Effect Settings
Transparency—Transparency settings
Drop Shadow—Drop shadow settings
Inner Shadow—Inner shadow settings
Outer Glow—Outer glow settings
Inner Glow—Inner glow settings
Bevel and Emboss—Bevel and emboss settings
Satin—Satin settings
Feather—Feather settings
Directional Feather—Directional Feather settings
Gradient Feather—Gradient feather settings

Frame Fitting—Frame Fitting options (including the 
Liquid Layout > Auto-Fit option)

Shape
Geometry—Shape (for example: triangle, circle, square, 
etc) If the source item is a point or a line and the target 
item is a text frame, the Geometry property is ignored. 
On by default.

Rotate—Rotation settings. Affected by active Reference 
Point position. On by default.
Shear—Shearing settings. Affected by active Reference 
Point position. On by default.
Match size—Match the size of the target object with 
the size of the source object. On by default.
Smart Connection: Elements—Controls the addi-
tion/removal of article components in order to match 
the target article with the source article or vice versa. 
Only available when using in combination with Smart 
Connection Enterprise. Off by default.

Text Frame Options
Inset spacing—Inset spacing options
Ignore Text Wrap—Ignore text wrap options
Vertical Justification—vertical justification options
Baseline Grid—Baseline grid options
Auto-Sizing—Auto-sizing options
Frame Height

Match Number of Lines—Match the number of lines  
of the target object with those of the source object, 
off by default.
First Baseline—First baseline settings. Off by default.
Match Height—Match frame height target object with 
frame height source object. Off by default.

Frame Width
Match Resize Behavior—Match the setting of the 
Column list (Fixed Number, Fixed Width, Flexible 
Width). On by default.
Match Width of Columns—Match column width. 
Off by default.
Match Number of Columns—Match number of col-
umns. On by default.
Match Width of Gutter—Match gutter width. Off by 
default.
Match Width—Match frame width. Off by default.

Text Wrap—Text wrap settings.
Footnotes—Footnote settings.

Object Constraints—Object Constraints settings as 
part of the Liquid Layout feature. (Requires the  Liquid 
Page Rule option to be set to “Object Based”.)
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Object Export Options
Alt Text—Alternative text of an image or graphic
Tagged PDF—Tag and actual text source
EPUB and HTML—Various options

2. Text Style

Paragraph Styles—Paragraph styles settings as set in 
the Paragraph Styles panel
Paragraph Settings—Paragraph settings as set in the 
Paragraph panel
Character Styles—Character styles settings as set in 
the Character panel
Character Settings—Character settings as set in the 
Character panel
Transparency Effect Settings

Transparency—Transparency settings
Drop Shadow—Drop shadow settings
Inner Shadow—Inner shadow settings
Outer Glow—Outer glow settings
Inner Glow—Inner glow settings
Bevel and Emboss—Bevel and emboss settings
Satin—Satin settings
Feather—Feather settings
Directional Feather—Directional Feather settings
Gradient Feather—Gradient feather settings

Optical Margin Alignment—Optical margin alignment 
settings

Appendix C  Smart Styles Element Properties
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3. Table Style

Table Styles—Table Style settings
Table Settings

Table—Table properties
Row—Row properties
Column—Column properties

Text Style
Paragraph Styles—Paragraph styles settings
Paragraph Settings—Paragraph settings
Character Styles—Character styles settings
Character Settings—Character settings

Cell Styles
Cell—Cell settings

Appendix C  Smart Styles Element Properties
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This appendix contains a basic explanation of how 
formulas are structured, including its syntax and 
cell range options.

1. Formula Basics

A formula performs a calculation on one or more cells in 
a table, based on the input by the user. This could be a 
simple addition, subtraction, division or a more compli-
cated calculation.

A basic formula looks as follows:
=(A1-12)+(B2-B1)

Here, the static value 12 is subtracted from the value in cell 
A1 and the outcome is added to the result of subtracting 
the value in cell B1 from the value in cell B2.

In Smart Styles, the formula itself is never displayed 
in the cell, only the outcome of the calculation. To 

add or edit a formula to a cell in InDesign or InCopy using 
Smart Styles, the Formula dialog box needs to be used. 
(For more information about the Formula dialog box, see 
chapter 12, Working With Tables.)

A formula always starts with an equal sign (=). The actual 
equation that follows it is called the syntax and needs to 
follow specific rules, otherwise the formula will not work.

Working With Formulas
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1.1  Constructing a Formula

Figure 1.1 shows in more detail how a formula is 
constructed:

Figure 1.1 The structure of a formula

A   Cell reference  B   subtraction operator  
C   Numeric constant  D   Function  E   Range reference

A

=(A1-12)+SUM(B1:B10)
CB D E

Table 1.1 Examples of functions
Function syntax remarks example

ABS() =abs(a1) Absolute (number without its sign). =ABS(-2) output: 2

Average() =Average(number1, 
number2) Average of range of numbers =AVERAGE(3,6) output: 4,5

Int() INT(number) Integer. Rounds a number down to 
the nearest integer. =INT(8.9) output: 8

Product() =product(number1, 
number2)

Product. Multiplies all the num-
bers given as arguments. =product(4,5) output: 20

Round() =ROUND(number, 
number_of_digits))

Rounds a number to a specified 
number of digits. =ROUND(8.35, 1) output: 8,4

Sum() =sum(A2:A4) Sum (adds all the numbers in a 
range of cells).

=sum(4:5) output: 9

Cell references
• The numbering of cells is identical to the one 
used in regular spreadsheet applications: the 
top cell in the first column is cell A1, the one 
below cell A2, the top cell in the second column 
is B1, and so on.

• To refer to individual cells, separate them by a 
comma. Example: (A1, A5). Here, the values in 
cell A1 and cell A5 are referenced.

• To specify a range of cells, separate them by a 
colon. Example (A1:A10). Here, cell A1 up to and 
including cell A10 are referenced.

• Header and footer cells cannot be included 
in the calculation. When referenced, #error will 
display as the formula value in the cell.

Function
• A function is used to perform a particular 
action on a range of cells. See table 1.1 for more 
details.
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